SayMore overview
As a Language Documenter, you quickly amass a large number of source
recordings and artifacts based on them. You need to manage those
recordings, document informed consent, transcribe, translate, enter
metadata, and, finally, submit to a digital archive. Along the way, you
need to keep all these files well organized and labeled. You'll want to
keep track of the goals of the project in order to emerge with the desired
coverage in areas such as genre, spontaneity, and the social roles of the
speaker. You will need some help keeping track of where each session is
in your workflow. SayMore can help with all that.
In summary, SayMore is a tool to organize video, audio, image, and
various other files, with appropriate metadata.

Work with a Project
Create or open a project.
Enter project metadata.

Organize Sessions
Add a session.
You can add an empty session or one with content from a new
recording. Further, you can add multiple sessions as you download the
day’s recordings directly off devices (camera, audio recorder, and so
on). In this case, SayMore creates Ids for each session. Each Id will
become the name of its folder, as well as the first part of most
filenames inside the folder. These are automatically updated if you later
change this Id metadata.
Enter session metadata.
Add any kind of file related to the session, including audio and video
recordings, photographs, & transcriptions. Keep using your preferred
annotation tools, such as ELAN. Enter file metadata for individual
files.
Rename files according to a naming standard to set stages of

completion of the documentation task.
Extract audio data from a video file.
Play or view files in SayMore, or open them in the associated
program.

Organize People Data
Keep a list of participants with applicable metadata in the People tab.
Add evidence of informed consent.
Rename files for informed consent.

Monitor Progress Towards Your Goals
Review progress information in the Project tab.
Copy, save, or print the progress data.

Archive your sessions and project
Archiving overview describes how SayMore helps you archive your
data.
Note
This program may occasionally transmit statistics (e.g., number of times
you've run it) to the developers via the internet. This is done to help us
know which of our free products are being used, and which features
people are finding most useful. This is critically important to setting our
priorities for future work.
Related Topics
Concepts overview
Getting Started
How SayMore uses file names
User Interface overview
Using Tools overview

Copyright and License
Copyright © 2011-2018 SIL International
This software is licensed under the MIT License
(http://opensource.org/licenses/MIT).
Permission is hereby granted, free of charge, to any person obtaining a
copy of this software and associated documentation files (the
"Software"), to deal in the Software without restriction, including without
limitation the rights to use, copy, modify, merge, publish, distribute,
sublicense, and/or sell copies of the Software, and to permit persons to
whom the Software is furnished to do so, subject to the following
conditions:
The above copyright notice and this permission notice shall be included
in all copies or substantial portions of the Software.
THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF
ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED
TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT
SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR
ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN
ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE
OR OTHER DEALINGS IN THE SOFTWARE.
SIL fonts and closely related software: the SIL Open Font License (OFL).
Related Topics

Getting Started

Get more help
SayMore is Open Source Software distributed for free. As such, there is
no warranty, and we cannot guarantee support. However, we and the
SayMore user community welcome your questions, suggestions, success
stories, and problem reports.
For problem reports, see Information for bug reports (below).
https://community.software.sil.org/ is a site that has discussions, howto information and a place for feature requests.
More information is available online. The SayMore site:
http://software.sil.org/saymore/.
Papers may be available on the Internet. For example:
https://www.academia.edu/6474779/Producing_timealigned_interlinear_texts_Towards_a_SayMore-FLExELAN_workflow

Information for bug reports
For some error messages, the contents of the error message appear in a
box that has a button you click to sent the error report via email. Any time
you submit a bug report, include the following:
The version and build date of the SIL SayMore program that you are
using.
On the Help menu, click About. Alternatively, click Open/Create
Project on the Project menu to open the SayMore dialog box.
A description of what happened:
What were you trying to get done?
How did you try doing it?
What did you expect to happen?
What happened instead?
Can you make the problem happen again? If so, what are the

exact steps?"
Note
If you submit an issue using a green or yellow error message box, you
do not need to include the version number as it is part of the content
submitted.
If you submit an issue via email to

issues@saymore.palaso.org, you need to include the
version number.
Related Topics
Getting Started

Getting started
SayMore is a tool you use to organize video, audio, image, and various
additional files with appropriate metadata. SayMore overview discusses
this in more detail.

Learning about SayMore
Concepts overview discusses concepts you need to understand.
User Interface overview and User Interface terms overview help you
learn about features and terms you see in SayMore.
Tabs overview groups sets of Help topics by tab.
Task topics are listed in
Menus
Basic Tasks overview
Using Tools overview
Project tab tasks
Sessions tab tasks
People tab tasks
A simplified practice topic is included.
It is only one of a number of possible work flows.

Other related topics
Copyright and License
Create a new SayMore Project
Get more help
Open a SayMore project

SayMore practice
Here is a simple practice script you can do to help learn about SayMore.
It is one of many possible work flows and is not a complete set of
typically-accomplished steps.
Hyperlinks in this topic are only provided as opportunities for you to
become more familiar with this Help system. Clicking them optional.
Prerequisites
One or more *.wav files of someone speaking.
Documents that you can use for informed consent (PDF file is
recommended.)
Picture of a person (optional).
A microphone you can use to record yourself.
An appropriate keyboard so you can type transcriptions (optional,
depending on the writing system).
Practice Script
1. On the Project menu, click Open/Create Project.
The SayMore dialog box opens. Notice that is shows existing
projects you can open, and a link to create a new project. Also,
notice that is shows the version of the program and some hyperlinks
to internet sites.
2. Under Create, click Create new, blank project.
3. Type the name you want to call this project, and then click OK.
The

Project tab appears with About This Project selected (more).

4. You can edit the project title and then type or select content in each
of the other fields. This information is project metadata.
5. Click Access Protocol, and then choose TLA. The choices provided
by TLA will be available for selection latter (more).

For this practice, look at the other areas, but we will not use
them.
6. Click the
Sessions tab, and then click the New button (lower left)
to add a new session.
7. In the Session tab (lower-right pane), enter or select metadata in
various fields (more).
At this point there are no person to select for the People field. So, let's
add one.
8. Click the

People tab, and then do the following:

Click the New button to add a person.
In the

Person tab, enter metadata about the person (more).

Click Add Files and select a picture of the named person
(optional).
Notice that the picture file appears in the top portion of the right
pane, and the picture is displayed in the lower-right tab.
9. In the People (left) pane, notice the yellow warning in the
Consent column. This indicates that you have not yet added a file
that gives this person's consent for the use of the his or her voice or
effort recorded in a media file (that you will add to this session). To
do this, do the following:
Click Add Files to select the file that gives the person's
consent, and click Open.
The file appears in the top portion of the right pane.
In SayMore, click that file, and then click Rename.
The Rename dialog box opens. Click Informed Consent, and
then click Rename.
Notice that file name changed. It now includes the session Id and
the word Consent.
Notice that the yellow warning has changed to an icon that

indicates that informed consent has been provided.
Let's return to the
10. Click the

Sessions tab.

Sessions tab.

11. In the Sessions (left) pane, hover your mouse point over the
rectangles in the Stages column. Notice that the Informed Consent
stage still shows Incomplete. This is because the person has not yet
been added to the session. So, we need to do the following:
With the session selected at the top of the right pane, look down
to the Session tab. Click the down arrow in the People field,
and select ( ) the person you added.
In the Sessions pane, hover your mouse pointer over the
rectangles in the Stages column again, and notice that now
Informed Consent is Complete. Also, the corresponding
rectangle changed color.
We now need to add the media file and associated files to the
session.
12. Click Add Files, and then select the <name>.wav file that is the
source recording for the session.
Alternatively, if you have the folder open that stores that file, you
can drag and drop the file into SayMore, above the Session
tab.
13. Click the added <name>.wav file, and then click Rename. In the
Rename dialog box, click Source, and then click Rename.
Notice that the file name changed, and includes the session Id and
the word Source.
Now, let's add annotations for this source file.
14. Click the <name>.wav file, and then click the Start Annotating tab.
The Start Annotating tab is only available until there is an
annotation file associated with the source file. It lists optional ways to
properly get a file with segments into SayMore.

15. Select Use Careful Speech Tool, and then click Get Started.
The Careful Speech Recorder dialog box appears. It is one of the
ways you can add segment boundaries that SayMore can recognize.
16. In the Careful Speech Recorder, insert segment boundaries as
follows:
Press and hold the SPACEBAR key to listen to the playback,
releasing the SPACEBAR key where you want a segment
boundary. Then, press and hold the SPACEBAR key while you
speak a careful speech equivalent for the segment. Release the
SPACEBAR key.
Repeat the above step until the entire source recording has
segments.
While the dialog box is still open (you have not yet clicked OK),
you can click individual segments and then listen ( ) to the
source file and check your annotation ( ). If you do not like your
annotation, you can erase it ( ), and then respeak it. If one or
more segments is not usable, you can click
to ignore it.
Ignored segments do not need annotations.
Click OK to close the dialog box.
Notice that now there is an Annotations tab, but not a Start
Annotating tab. Notice too, that now there is a
<name>.wav.oralAnnotations.wav file in the top-right portion of
the
Sessions tab.
17. Click the <name>.wav.oralAnnotations.wav file.
Notice that the first tab is called Generated Audio (more). The
display shows waves for the source recording and careful speech
annotations, but there is not yet waves for the any oral
translation.
We will add the Translation next, but at this time you may want
to click Play to listen to the Source and Careful tracks.
18. Click the

<name>.wav.annotations.eaf file. Notice that

Annotations is the first or only tab. When this tab is selected there
is a Oral Annotations Tools button.
19. Click the Oral Annotations Tools button, and then click Oral
Translation (more).
The Oral Translation Recorder dialog box opens. Notice that it has
the segments boundaries you previously added.
20. Record oral translations for each segment as follows:
Press and hold the SPACEBAR key to hear one segment of the
source recording. Release the key.
Press and hold the SPACEBAR key again while you speak an
oral translation of that segment.
Repeat the steps above until each segment of the file as an oral
translation.
Click OK.
Now, with the <name>.wav.oralAnnotations.wav file selected,
notice the Generated Audio tab, and that it now shows a
waveform for Translation.
21. Click Play to listen to the Source, Careful and Translation
tracks.
22. Click the Properties tab, and notice the metadata for the selected
file.
23. In the top portion of the right pane, click the <name>.Source.wav
file.
24. Click the Contributors tab, and enter the name of a contributor;
select a role, select a date and add any comments about the
contributor you want to include.
25. Click the

<name>.wav.annotations.eaf file.

26. In the Annotations tab, do the following to add transcriptions and
free translations:
Make sure you have an appropriate keyboard so you can type

the transcriptions.
Click the cell that is in the Transcription column, first row
(segment).
As you listen to that segment playing repeatedly, type a phonetic
transcription of that segment. If necessary, click to pause the
playback, and to restart the playback of that segment.
Repeat for each row (segment).
27. In the Annotations tab, do the following to enter free translations:
Click the cell that is in the Free Translation column, first row
(segment).
As you listen to that segment playing repeatedly, type a free
translation of that segment. If necessary, click to pause the
playback, and to restart the playback of that segment.
Repeat for each row (segment).
Click the Project tab, and the click Progress to review the
progress metadata associated with the project.
Now, lets add another session and media file. This time, we will use
the Manual Segmentation Tool to add the segments.
28. Click the

Sessions tab.

29. Click New, and enter session metadata in the

Session tab.

30. Click Add Files, and the select the desired media file.
31. Click added <name>.wav file, and then rename it to be a source file
as described above.
32. Click the Start Annotating tab.
33. Select Use Manual Segmentation Tool, and then click Get Started.
34. In the Manual Segmenter dialog box (more), insert segment
boundaries as follows:
Press the SPACEBAR key to start the playback, and while you

listen press the ENTER key at each location where you want to
add a segment boundary.
While the dialog box is still open (you have not yet clicked OK),
you can click individual segment boundaries to select them. Then
you can move that segment boundary, or press DELETE to
delete it.
Notice that the number of segments and duration values are
displayed.
35. For this media file, typically, you would now record both Careful
Speech and Oral Translation tracks, and type Transcription and
Free Translation content for each segment (as described above).
36. When you are ready, you can archive an session to IMDI:
In the Sessions (left) pane, click the session you want to archive,
and then on the Session menu, click Archive using IMDI.
For this practice exercise, look at the dialog box but do not
archive your practice data.
37. You can export the Transcription and Free Translation data to a
file that can be imported into FieldWorks Language Explorer (FLEx).
Do this as follows:
Click the <name>.wav.annotations.eaf file that has the
Transcription and Free Translation data you will export.
Click the Annotations tab.
Click Export, and then click FLEx Interlinear Text. In the
export dialog box that appears, select the writing system used for
the transcription and free translations, and then click Export.
In the Export to File window, navigate to an appropriate folder.
The File Name and Save as type boxes should not need to be
changed, so click Save.
In FLEx, go to Texts & Words, and then click Interlinear Texts.
On the File menu, point to Import and then click FLExText
Interlinear. Select the file, and the click Open.

Now you see the path to the file in the FieldWorks Interlinear
(FLExText) file dialog box. Click OK.
The transcription data appear in the Baseline tab, and in the
Word line of the Gloss and Analyze tabs. The Free Translation
data appear in the Free lines of the Gloss and Analyze tabs.
Related Topics
Getting Started
Glossary of Terms/Symbols

Concepts overview
Concepts to consider when you use SayMore include the following (not
exhaustive):
Concept topics
Access Protocol

(cont.)
Genre

AILCA

How SayMore uses file names

AILLA

IMDI

ANLA

Informed Consent

ELAR

Metadata (IMDI)

REAP

Metadata (RAMP)

TLA

Oral Translation

Arbil

Person

Audacity

Project

BOLD Methodology

Role list sample

Careful Speech

Session

Contributor

Source Recording

ELAN

Stages of completion

FFmpeg

Subordinate files example

File formats in SayMore

Transcription

Folder structure

Written Translation

See Also: Glossary of Terms.
Related Topics
Custom Fields
SayMore overview

User Interface terms overview

Access Protocol
Access determines who has permission to get or see your archived data.
Access Protocol, and possibly other factors known to curators, are used
to determine what access to assign to an item in archives. You choose
the access protocol for the project in the Project tab.
Unless your organization instructs you differently:
SIL members or others with permission to use REAP/RAMP, choose:
REAP.
All others, choose one of the following:
AILCA
AILLA
ANLA
ELAR
TLA
Custom.
Select session access uses the Access field. It lists the choices
offered by the particular access protocol you choose or the custom
access choices you typed.
Related Topics
Choose Access Protocol
Concepts overview
Localizing Access Protocol Information

AILCA
The primary mission of The Archive of Indigenous languages and
Cultures of Asia (AILCA) is the long-term preservation of endangered
Asian languages.
AILCA is an access protocol option you can choose.
Access choices it provides:
F - access is Free to all.
U - all Users can access (requires registration).
RC - Researchers and Community member are allowed access.
C - only Community members are allowed access (normally requires
application to Depositor).
S - only Subscribers are allowed access (required application to
Depositor).
- Only the Depositor and delegate can access.
("Blank" is a valid option. It is the most restrictive option).
Related Topics
Concepts overview
Get more help
Related Internet Sites
http://diha.ntu.edu.sg/about.html
http://diha.ntu.edu.sg/home.html

AILLA
The Archive of the Indigenous Languages of Latin America (AILLA) is a
digital archive of recordings and texts in and about the indigenous
languages of Latin America.
AILLA is an access protocol option you can choose.
Access choices it provides:
Level 1. Public access - Archive users have full access to these
materials after agreeing to AILLA's Terms and Conditions and logging
in. Choose this level for all non-sensitive materials. This is the default
level.
Level 2. Password - When you deposit with the archive, you will
define a password with an optional hint. You can provide access to
others by sharing the password with them. This is the most flexible
level.
Level 3. Time limit - When you deposit with the archive, you specify
a date After that date, access will change to Level 1. This option is
good for resources that are only sensitive for a period of time. For
example, the period of time could be the lifetime of the narrator or the
five years until you finish your thesis. You will still be able to access
these materials yourself with the password.
Level 4. Depositor control - Archive users must contact you directly
to ask you for the password. AILLA will provide contact information.
You must maintain your contact information and be prepared to
respond to requests from people you do not know.
Related Topics
Concepts overview
Get more help
Related Internet Sites
http://www.ailla.utexas.org/site/welcome.html

http://www.ailla.utexas.org/site/access_restrict.html#levels

ANLA
The Alaska Native Language Archive (ANLA) is a repository for materials
which document the indigenous languages of Alaska. ANLA will consider
for accession any written material and recordings in and about the
indigenous languages of Alaska.
ANLA is an access protocol option you can choose.
Access choices it provides:
Unrestricted access - Any member of the public may access the
material for nonprofit use.
Time limit - When you deposit with the archive, you will specify the
date. Before that date, access is fully restricted. After that date,
access will change to Unrestricted access.
Restricted access - When you deposit with the archive, you will
specify restrictions on access. For example, "access only with
permission of village council", "Access only with permission of
descendents", etc.
http://www.uaf.edu/files/anla/deed_of_gift.pdf has additional information,
such as how to communicate with the archive personnel.
Related Topics
Concepts overview
Get more help
Related Internet Sites
http://www.uaf.edu/anla/

Arbil
Arbil (Archive Builder) is a general metadata editor, browser & organizer
tool for IMDI, CMDI (Component MetaData Infrastructure), and similar
metadata formats that are appropriate for archiving. Arbil is designed so
that it can be used off-line in remote locations. The data can be entered
at any stage in part or as a whole. When an internet connection is
available the work can then be transferred to the main archive via
LAMUS.
Note
Arbil (http://tla.mpi.nl/tools/tla-tools/arbil/) and LAMUS
(http://tla.mpi.nl/tools/tla-tools/lamus/) are tools of the Max Planck
Institute for Psycholinguistics, Nijmegen, The Netherlands.
TLA is their archive.
IMDI is their metadata standard.
Related Topics
Concepts overview
ELAN

Audacity
Audacity in an open-source program which you can use for audio-related
tasks.
You can use Audacity to:
trim the start and end portions of recordings
reduce background noise
divide recordings into separate files
identify segment boundaries
add initial transcriptions of each segment.
Media Annotation overview gives a general overview of media
annotation, and the required files.
Detailed instructions for Audacity are beyond the scope of these
SayMore User Helps.

General steps for using Audacity
1. Do one of the following:
Start Audacity, and then open an existing file.
If you start from a video file, extract an audio file. Then, open that
extracted audio file in Audacity. (You can use Show in File
Explorer to find the file, and drag it into Audacity.)
If you use Audacity for its other functions (trimming, editing, and
so on), bring the result into SayMore as a new session:
In the Sessions tab, click New From Device and select the
Audacity audio file. If you have also done segmentation or
labeling in Audacity, follow the below steps, keeping the
filenames consistent.
2. On the Audacity Tracks menu, point to Add New, and then click
Label Track.
3. In Audacity, click Play.

4. Select a segment, press Ctrl+B or Ctrl+M to insert a label, and then
type the annotation.
5. On the Audacity File menu, click Export Labels. Save the file with
an appropriate name in a convenient location on your computer.
6. To use that Audacity file as the basis for the annotation file for the
SayMore audio file of the same name, in SayMore, use the Read an
Audacity Label file option on the Start Annotating tab.
Then you can work with oral translation annotations and careful speech
annotations, and with transcription and free translation annotations.
Note: The above use of the Audacity Label File will only be possible if
you have not already clicked Get Started with another segmentation
method selected in the Start Annotating tab.
Related Topics
Concepts overview
Related Internet Sites
http://audacity.sourceforge.net/download/
http://manual.audacityteam.org/
http://manual.audacityteam.org/man/faq.html

BOLD Methodology
Basic Oral Language Documentation (BOLD) is a simple technique for
collecting oral texts and making their content accessible to a broad
audience. BOLD only requires inexpensive recording technology and
limited training. The work is intended to complement other languagerelated activities, such as language development, literacy training, and
linguistic research.
SayMore supports BOLD (Basic Oral Language Documentation)
methodology through stages of completion and some of the User
Interface terms.
Tip
Will Reiman described the use of recording devices in this document:
http://scholarspace.manoa.hawaii.edu/bitstream/10125/4479/1/reiman.pdf
(Reiman, D. Will. 2010. Basic Oral Language Documentation.
Language Documentation and Conservation 4. 254-268).
Related Topics
Concepts overview
Related Internet Sites
http://www.boldpng.info/BOLD

Careful Speech
Careful speech is the intentionally-careful "respeaking" of the words in
the source recording at a location that is free from background noise and
interruptions.
By contrast, the source recording is spoken in a more natural way.
Careful Speech is one of the stages of completion.

Tools
You can do any of the following:
Use the Careful Speech Tool to
create an annotation file, or
record Careful Speech annotations for an existing annotation file.
Use an external device, and then add the resulting file to the SayMore
session. Rename the added file.
For careful speech recording, consider the following,
Use recording devices, as described by Will Reiman:
http://scholarspace.manoa.hawaii.edu/bitstream/10125/4479/1/reiman.pdf
(Reiman, D. Will. 2010. Basic Oral Language Documentation.
Language Documentation and Conservation 4. 254-268).
You can record and play using a computer and an application like
Audacity.
Related Topics
Annotations tab overview
BOLD methodology
Careful Speech in Glossary of Terms
Concepts overview
ELAN

Generated Audio tab
Select session stages
Related Internet Sites
http://audacity.sourceforge.net/
http://manual.audacityteam.org/
http://en.wikipedia.org/wiki/Audacity

Contributor
In SayMore, a contributor is someone who only had a contributory role in
the development of an added file. Therefore, a contributor is handled
differently than a person.
Specifically, a contributor is not listed in the People tab unless that
individual had also done something beyond any of the contributory roles,
such as was recorded, completed a written transcription, and so on.
Two tabs display contributions from two different points of view:
The
Sessions tab displays a Contributors tab which lists names
and roles of those who contributed to the current file. See: Use
Contributors tab.
The
People tab displays a Contributions tab which lists sessions
to which the current person has contributed. See: Use Contributions
tab.
Related Topics
Concepts overview
Metadata (RAMP)
Person

ELAN
ELAN (EUDICO Linguistic Annotator) is a professional tool for the
creation of complex annotations on video and audio resources. It is a tool
of the Max Planck Institute for Psycholinguistics, Nijmegen, The
Netherlands (http://tla.mpi.nl/tools/tla-tools/elan/).
SayMore uses ELAN's file format (.eaf) for its annotation files, so you can
begin using SayMore for its simplicity and then use ELAN when your
annotation needs become more sophisticated (more).
ELAN allows a richly nested and flexible set of tiers, which may be
different for each media file. When SayMore uses an ELAN file as the
basis for a creating media file's annotation file, it expects certain tiers to
exist in that ELAN file. Others may be present, but they will be ignored by
SayMore.
If you have an existing ELAN file and would like to associate it with a
media file in SayMore, the following must be true:
There is a Transcription tier which has a type for which Timealignable is selected ( ).
If you already have a tier for translation of those phrases, it must be:
a child of Transcription
named Phrase Free Translation
have a type for which the stereotype is Symbolic Association.
To use an existing ELAN file as the basis for a SayMore annotation file,
select Copy an existing ELAN file on the Start Annotating tab. Then you
can work with oral translation annotations and careful speech
annotations, and transcription and free translation annotations.
If necessary, open the file in ELAN and work with transcription and free
translations there. Be careful not to remove or rename the
'Transcription' and 'Free Translation' tiers, or add any additional tiers.
Note
You can drag an ELAN file into a session just like any file, and then

add contributors and notes. However in this case, SayMore will not
treat the file as an annotation file.
A Missing Media File tab appears in the
Sessions tab if you click
a <name>.eaf file but SayMore could not find the media file. It shows
the path to where SayMore expected to find the media file. That path
includes the expected file name.
In the top portion of the right pane, the Type column indicates that
missing media, for example, AnnotationsWithMissingMedia.
Related Topics
Concepts overview
Media Annotation overview
Sessions tab description
TLA
Related Internet Sites
http://tla.mpi.nl/tools/tla-tools/elan/download/
https://www.academia.edu/6474779/Producing_timealigned_interlinear_texts_Towards_a_SayMore-FLEx-ELAN_workflow

ELAR
The Endangered Language ARchive (ELAR) is a digital repository
preserving and publishing multimedia collections of endangered
languages. In SayMore, it is an access protocol option you can choose.
Here are the three account status types used by ELAR:
O - Open to unregistered visitors
U - all ordinary Users can access
S - only Subscribers are allowed access (requires application
to Depositor).
http://www.elar-archive.org/using-elar/access-protocol.php has more
details about these account status types and ELAR in general.
Related Topics
Access Protocol
Concepts overview
Get more help
Project tab description

FFmpeg
To get the most out of SayMore, you need to install a separate, free utility
called "FFmpeg". It is a command line tool to convert multimedia files
between formats (http://www.ffmpeg.org/about.html).
SayMore uses it to
automatically fill in media metadata (Duration, Channels, Bit Depth,
Sample Rate, and so on)
perform useful conversions of your media from one format to another.
For example, with FFmpeg installed, SayMore can extract an
audio file from a video file.
Note
FFmpeg comes with many audio/video-related programs. If you do
not already have it, but have a connection to the Internet, run this
installer, or find an alternative from audacity.
If you do not have FFmpeg installed when you open the Convert
Media dialog box, the Begin Conversion button is not available, but
the Install button is. Click Install to open and use the Install FFmpeg
dialog box features.
Related Topics
Concepts overview
File formats in SayMore
Related Internet Sites
http://www.FFmpeg.org/FAQ.html
http://manual.audacityteam.org/man/faq_installation_and_plug_ins.html

File formats in SayMore
Some audio formats are not good for use in SayMore, or for archiving
and subsequent use.
File Conversion Required appears in the Start Annotating tab if the
selected file needs to be converted. Click Convert and let SayMore
convert it. Otherwise, you cannot choose a segmentation method.
After conversion you see both the source file and the converted copy
of that file.
StandardAudio.wav is added to the file name of the converted
copy.
Both files are included in the archive package.
Audio formats that normally do not need to be converted (not
exhaustive)
Format

About

WAV PCM

http://en.wikipedia.org/wiki/PCM

AAC Audio

http://en.wikipedia.org/wiki/Advanced_Audio_Coding

FFmpeg
output

Formats listed at:
http://en.wikipedia.org/wiki/FFmpeg

Audio formats that normally need to be converted (not exhaustive)
Format

About

mp3

http://en.wikipedia.org/wiki/Mp3

IEEE
FLOAT

http://en.wikipedia.org/wiki/IEEE_754-2008

255-Voice
PCM

http://www.radiolocman.com/shem/schematics.html?
di=84101 (based on 8-pin SD audio player)

WAV

http://www.fileguru.com/apps/mwaudio_decoder_dmo

WMAUDIO2
Related Topics
Concepts overview
Convert Media
Folder structure
Informed Consent
How SayMore uses file names

How SayMore uses file names
Informative, consistent file names are very important in language
documentation. They help you know what you have and don't have, and
they will help consumers of your material in the future.
SayMore aims to help you with the task of keeping your files properly
named.
This can begin, for example, when you import a media file using New
From Device. SayMore first includes the Id of each session in the file
name, which is usually some uninformative code made up by your
recording device, like "ZOOM0003". Next, when you change that Id to
something fitting your own scheme, SayMore goes through all the files in
the session and replaces all the old Ids with the new one.
As you add new files to the session or person, you can tell SayMore to
rename them to fit their purpose. SayMore uses correctly renamed files
to update your progress information, stages of completion and visual
indicators.
Rename dialog box option

Addition to file name

Source

Source

Informed Consent

Consent

Careful Speech

Careful

Oral Translation

OralTranslation

Transcription

Transcription

Written Translation

Translation

In the Rename dialog box, hover your mouse pointer over an option (link)
to see a brief description.
Related Topics
Concepts overview
File formats in SayMore

Folder structure
New From Device

Folder structure
An important value of SayMore is avoiding opaque databases, which
would be unusable apart from SayMore, and thus poor choices for the allimportant archiving step of Language Documentation. Instead, SayMore
keeps your data in forms that are easy to "get at" and understand, now
and in the distant future.
One way SayMore does this is by keeping all the data for a given project
in a single folder, named after the project. The "project" folder has two
subfolders, one for people, and one for sessions:
In the People folder, there is a folder for each person, named with the
Full Name.
Each person's folder contains their associated files, such as their
informed consent and picture files.
In the Sessions folder, there is a folder for each session, named with
the Id.
Each of these subfolders also have subfolders containing segment and
annotation files. If you change the Id, the folder and files names are all
changed.
Additionally, DescriptiveDocuments or OtherDocuments folders are
added to the project folder when you add a file to Descriptive
Documents or Other Documents in the Projects tab.
Note
Typically, on Windows®, SayMore stores the project folder here:
C:\Users\<you>\Documents\SayMore
But you can
move a project folder to another location on your computer or to
removable external drives.
copy a project folder to another computer to begin collaboration.
Do not directly rename or move individual folders inside your projects

main folder.
Related Topics
Concepts overview
Create a new SayMore project
File formats in SayMore
Open a file
Open (file) in program associated with this file
Rename file

Genre
In SayMore, a genre is a class or category of the session having a
particular form, content, technique, and so on. You can select a genre
from a list, or type in a new genre, when you enter session metadata.
Related Topics
Concepts overview

IMDI
IMDI (ISLE Meta Data Initiative) is a metadata standard that is used to
describe multi-media and multi-modal language resources.
In SayMore, the labels (UI terms) generally reflect IMDI standards, such
as described here:
http://tla.mpi.nl/wp-content/uploads/2012/06/IMDI_MetaData_3.0.4.pdf.
Note
IMDI (http://tla.mpi.nl/imdi-metadata/) is the metadata standard of the
Max Planck Institute for Psycholinguistics, Nijmegen, The
Netherlands.
Arbil, LAMUS and ELAN are their tools.
TLA is their archive.
Related Topics
Concepts overview
Metadata (IMDI)

Informed Consent
If you want to use or share any recordings of people, it is your
responsibility to both help them understand their rights and to document
how they want their recordings to be used. This can be quite challenging
in remote, non-digital cultures, but it's the right thing to do. It is also
necessary to prevent your hard work from becoming inaccessible in the
future because of a lack of effort and evidence now.
Informed Consent is one of the stages of completion.
Informed consent may be in the form of an audio/video file of
conversation about consent, photographs, a signed form, a photograph of
a signed form, and so on.
For the file or files that provide informed consent, click the Rename
button, and then click Informed Consent.
Normally, add and rename a file for each person in your
list.

People

However, suppose you add a file in which a large number of
people are involved. It may be impractical to get informed consent
from each of them. You may need to add a file from someone
representing the entire group. In this case, add the file to the
session, not to a person, and rename that file as the informed
consent for the group.

Consent column
A column named Consent appears in the People pane (left in People
tab):
appears if there is no file that includes "Consent" in the file name.
If there is file with "Consent" in the file name, then a different icon
appears according to the kind of file:
(text file)
(audio file)
and so on.

Note
Currently, SayMore does not help you with those situations where one
person has different wishes with respect to different sessions. This is
planned for a future version. See Also:
http://saymore.palaso.org/news-about-saymore/.
The Stages column indicates if all of the needed consent documents
are on file.
Each different file type has a different icon. Some of them are shown
in the Symbols section (Glossary of Terms).
Related Topics
Concepts overview
How SayMore uses file names
Multiple consent forms
Rename a file
Related Academic Publications and Internet References
Informed consent among analog people in a digital world (Robinson
2009)
Documentary Linguistics and Ethical Issues (pdf) (Theiberger, Musgrave
2007)
Copyright Essentials for Linguists (Newman 2007)
Query Google scholar for "informed consent" and "language
documentation"
http://creativecommons.org/licenses/

Metadata (IMDI)
Metadata is "data about data." There is project, session, person and file
metadata.
SayMore fields and their labels generally reflect IMDI standards. Content
in fields is included as metadata when you archive the project or session.
When you archive the project, you can choose to archive only metadata.
Related Topics
Arbil
Concepts overview
Metadata (RAMP)
More Fields
User Interface terms overview

Metadata (RAMP)
Metadata is "data about data." There is project, session, person and file
metadata.
This table shows how SayMore adds metadata to RAMP when you
archive a session.
RAMP Field

SayMore
Field

Note

Title

Title

Id of session, if Title is
empty.

Broad Type

None

SayMore selects Wider
Audience.

Mode

None

Determined by the type of
files in the session. Audio
files are assumed to be
”r;Speech”; image files
are assumed to be
”r;Photograph”.

Scholarly Work Type

None

SayMore selects Primary
data.

Contributors

Contributors

(see Note below.)

Date

Date

Description:Abstract

Description

If there is content in the
Description field, then a
Y appears to indicate
there is an abstract.
Otherwise, "No data
entered" is displayed.

Resource Sub-Type

None

SayMore selects
Language
Documentation (LING).

Academic Domain

None

SayMore selects
Linguistics.

Audio/Video Extent

None

The sum total of the
length of all media files
marked as Source.

Electronic Files

None

All the files in the session
plus the files associated
with each contributor are
included.

Note
For Contributors, currently contributor entries are not made for each
person specified in a session, but that is the plan. Currently,
contributors and their roles need to be manually added in the RAMP
package.
Related Topics
Concepts overview
Metadata (IMDI)
Sessions tab description
User Interface terms - Sessions tab
User Interface terms overview

Oral Translation
An oral translation is a spoken translation. It is done by speakers of the
vernacular language (Content Language) to a different language
(Working Language). See Also: About This Project.
Oral Translation is one of the stages of completion.

Tools
You can do either of the following:
Record Oral Translation annotations.
Use an external device, and then add the resulting file to the SayMore
session. Rename the added file.
For oral translations, consider the following:
Use recording devices, as described by Will Reiman:
http://scholarspace.manoa.hawaii.edu/bitstream/10125/4479/1/reiman.pdf
(Reiman, D. Will. 2010. Basic Oral Language Documentation.
Language Documentation and Conservation 4. 254-268).
You can record and play using a computer and an application like
Audacity.
Related Topics
Annotation tab overview
BOLD methodology
Concepts overview
ELAN
Generated Audio tab
Oral Translation in Glossary of Terms
Select session stages
Written Translation

Related Internet Sites
http://audacity.sourceforge.net/
http://manual.audacityteam.org/
http://en.wikipedia.org/wiki/Audacity
http://en.wikipedia.org/wiki/Language_of_wider_communication

REAP/RAMP
REAP (Repository for Electronic Archiving and Publishing) is the archive
of SIL International. RAMP (Resource and Metadata Packager) is the
desktop tool for adding metadata and submitting archive packages to
REAP.
REAP is an access protocol option you can choose.
Access choices it provides:
Entity curators - Restricts access to REAP curators of the entity
collections; no redistribution is permitted.
Entity - Restricts access to only member of the entity staff;
no redistribution is permitted.
Insite users - Allows access by registered Insite users with no public
redistribution allowed except by official, written permission.
Strategic partners - Allows access by registered Insite users and
sharing with specific global partners privately.
Public - Material may be distributed/published/posted for public
consumption.
Graphically

Important

The RAMP package filename is <title>.ramp. For the filename, any
spaces and punctation are removed from the session title.
Curators can reject in-process submissions and withdraw (hide from
view) accepted items. They check the access level you select and
communicate with you if this differs from the default. Entities have the
final say regarding assess.
SIL Insite (https:):
When should I use the Entity Curator setting?
Access-permissions
With RAMP, if you do not have an internet connection, you can do the
following:
In RAMP, click the Actions button, and then click Export to export
the package to a location on your computer's hard drive, or to a
removable device.
When you (or someone else with RAMP) have an internet
connection, do the following:
If the package is on a removable device, click the Actions
button, and then click Import to import the package.
Click Actions, and then click Upload to upload the package to
REAP.
Related Topics
Access Protocol
Choose Access Protocol
Concepts overview
Metadata (RAMP)
Relate Internet Sites
https://www.ramp.insitehome.org/ (requires SIL member account)
https://www.help.insitehome.org/reap/ (requires SIL member account)

Person
In SayMore, a person is defined as someone who is recorded, completes
a transcription or written transcription, and so on.
A person differs from someone who only helps as a contributor and is
handled differently in SayMore. A person is:
added and described in the People tab (more)
selected in the People field for each session (more).
See Also: People tab description.
Related Topics
Concepts overview
Contributor

Project
In SayMore, a "project" is a particular language documentation effort.
Each project consists of:
project metadata
sessions and associated session metadata
people and person metadata
contributors in other roles
added files and file metadata.
Tabs overview lists topics that describe and help you use
features.

Project tab

Project menu overview lists commands on that menu.
Folder structure describes the folders that SayMore adds and uses.
Stages of completion describes stages towards project completion.
Archiving overview describes options for archiving individual sessions or
the project.
Related Topics
Concepts overview

Role list sample
For each contributor, you choose a role.
Here is a sample of the Role field drop-down list you see with you use
the Contributors tab. You cannot edit the list of roles.

Tip
If you type the first letter of a role, the first role that begins with that
letter appears is selected.
For example, type 't' to select Transcriber. Then, press your down
arrow key to move select Translator. Press the ENTER key to put
that selection in the cell.
deletes the entire row.
Related Topics

Enter file metadata
Sessions tab description

Session
In SayMore, a session is a collection of files and metadata related to one
source recording.
Depending on your work flow, you will likely start with one recording,
which is initially the only file related to the session.
Next, you enter metadata about that recording, information about the
person, genre, and so on. Over time, you will add other files to the
session which augment that recording: a careful speech recording, a
transcription, a free translation, an interlinearization, and so on.
Each session has an Id which you determine, and all of these files will be
kept together in a single folder named with that Id. In addition to being
kept together in a folder, you will want the names of each of these files to
contain that Id. SayMore will help you manage those file names.
Note
This use of Session is not to be confused with a broader use of the
term, such as Wedding or Festival, which could span several days,
and thus several recordings. A SayMore session is simply one source
recording that you will transcribe and translate, plus the various
supporting files. If you have several recordings pertaining to one
"event", use the ID and name fields to help identify their relationship.
From http://tla.mpi.nl/wpcontent/uploads/2012/06/IMDI_MetaData_3.0.4.pdf:
"The session concept bundles all information about the circumstances
and conditions of the linguistic event, groups the resources belonging
to this linguistic event, records the administrative information of the
event and describes the content of the event. Since version 3.0 also
written resources other than annotations can be included in a session.
For written resources the definition of session is extended to include all
documents that pertain to the creation, analysis and commentary of a
document."
Related Topics

Archive
BOLD Methodology
Folder Structure
Sessions tab description
Sessions tab tasks
Sessions tab User Interface terms
Stages of completion

Source Recording
A source recording (previously original recording) is an audio capture of a
linguistic session, or a version that may have been "cleaned up". The
"cleaned-up" version is not careful speech.
Source Recording is one of the stages of completion.

Tools
You can do any of the following:
Add a session from device.
Add a session from a new recording.
Use an external device, and then add the resulting file to a session.
Rename the file.
For source recordings, consider the following:
Use recording devices, as described by Will Reiman:
http://scholarspace.manoa.hawaii.edu/bitstream/10125/4479/1/reiman.pdf
(Reiman, D. Will. 2010. Basic Oral Language Documentation.
Language Documentation and Conservation 4. 254-268).
You can record and play using a computer and an application like
Audacity.
Typically one would do the following: Turn on the recording device.
Then, speak the file identifier, date and location, and names of the
speaker(s), while checking that the sound-level indicator is working.
Do this before putting the recorder close to the main speaker(s). A
speaker may want to re-start the recording, at which point the
operator presses the stop button and then begins a fresh recording
with the same introduction as before, without deleting anything.
Related Topics
BOLD methodology
Concepts overview

ELAN
Informed Consent
Select session stages
Related Internet Sites
http://audacity.sourceforge.net/
http://manual.audacityteam.org/
http://en.wikipedia.org/wiki/Audacity

Stages of completion
A stage is a task to do towards the completion of one session in a project.
In the
Sessions tab, the Sessions pane (left) has a Stages column. It
displays a set of rectangles:
A white rectangle indicates that the stage is incomplete, because
there is not an appropriately named file, and/or
there is no annotation data in the corresponding column (such as
Transcription or Free Translation).
A colored rectangle indicate that the stage is complete, because
there is an appropriately named file, and/or
there is annotation data in the corresponding column.
For any session, hover your mouse pointer over the indicator in the
Stages column to see its legend. Example:

Stages:
Source Recording
Informed Consent
Careful Speech
Oral Translation
Transcription
Written Translation
SayMore automatically keeps track of stages by default, but you can
choose to make it a manual task.
Related Topics
BOLD Methodology
Concepts overview

Edit stages
Generated Audio tab
Review progress data
Sessions tab description
User Interface terms - Sessions tab

Subordinate files example
Annotations file and OralAnnotations file appear subordinate
(indented in a hierarchical structure) to the Audio file. They store the
annotation and segmentation data for it.
Example

Tip
When you have a set of similar files, click each file and observe which
tab or tabs are available.
Related Topics
Delete annotations
Record Careful Speech annotations
Record Oral Translation annotations
Use Contributors tab
Working with annotations (Transcriptions and Free Translations)

TLA
TLA (The Language Archive) is an access protocol option you can
choose.
Access choices it provides:
Open - Resources can be accessed immediately.
Restricted - Restricted open resources can be accessed by
registered users which possibly (as in the case of DOBES) have to
agree with a Code of Conduct.
Protected - In addition to the conditions that hold for restricted
resources, protected resources can be accessed on request only. The
responsibles (usually the depositors) will examine the request and, if
they grant access, they may do so for a specific use or limited amount
of time, which may have to be agreed upon in a usage declaration.
Closed - Can be accessed only by the depositors (and, e.g.,
members of the respective speech community).
Note
The Language Archive (https://tla.mpi.nl/) is the archive of the Max
Planck Institute for Psycholinguistics, Nijmegen, The Netherlands.
See Also: http://tla.mpi.nl/resources/access-permissions/
Arbil, LAMUS and ELAN are their tools.
IMDI is their metadata standard
Related Topics
Concepts overview
Get more help

Transcription
A transcription is a written record, in the vernacular language (Content
Language), of the words spoken in the source recording. By contrast, the
written translation uses a different language.
Transcription is one of the stages of completion.

Tools
You can do either of the following:
With the <name>.type.annotations.eaf file selected, the
Annotations tab is displayed. You then type the transcription of each
segment in the Transcription column. When each segment has a
transcription, the Transcription stage is marked as complete.
Use an external device, and then add the resulting file to the SayMore
session. Rename the added file.
For oral transcriptions, consider the following:
Use recording devices, as described by Will Reiman:
http://scholarspace.manoa.hawaii.edu/bitstream/10125/4479/1/reiman.pdf
(Reiman, D. Will. 2010. Basic Oral Language Documentation.
Language Documentation and Conservation 4. 254-268).
You can record and play using a computer and an application like
Audacity.
Related Topics
Annotation tab overview
BOLD methodology
Concepts overview
ELAN
Select session stages
Transcription in Glossary of Terms

Work with annotations
Related Internet Sites
http://audacity.sourceforge.net/ (http://en.wikipedia.org/wiki/Audacity)
https://tla.mpi.nl/tools/tla-tools/elan/
http://sourceforge.net/projects/trans/files/transcriber/

Written Translation
A written translation is a written record of the words in the source
recording translated into a different language, usually a Language of
Wider Communication.
By contrast, the transcription uses the vernacular language (Working
Language).
Written Translation is one of the stages of completion.

Tools
You can do either of the following:
With the <name>.type.annotations.eaf file selected, the
Annotations tab is displayed. You then type the translation of each
segment in the Free Translation column. When each segment has a
translation, the Written Translation stage is marked as complete.
If you have a text file that contains the written translation of the audio
in this session, add that text file (pdf recommended), and then rename
it.
Related Topics
Annotation tab overview
BOLD methodology
Concepts overview
Oral Translation
Select session stages
Written Translation in Glossary of Terms

Basic Tasks overview
The workflow or sequence of actions accomplished in SayMore depends
on various factors, such as these:
Do you already have files ready to collect in SayMore sessions?
Do you have a computer conveniently available while making the
source recordings?
How many different people will contribute in roles of speaker,
transcriber, translator, and so on?
Using Tools overview lists tasks you do in particular tabs. Menus also list
some tasks. The stages of completion can help you make sure you are
completing the necessary tasks.
Here are tasks that you may do often or in more than one SayMore tab:
Add Files
Archiving overview
Archive a project
Archive a session
Work with columns:
Change column width
Choose columns
Reorder columns
Sort columnar data
Customize file naming convention
Delete a file
Edit Stages
Edit file metadata
Import metadata

Move or Copy a project folder
Multiple consent forms
Open in Program Association with this File (such as to edit it)
Play a media file
Recording
Rename file (for stages of completion)
Resizing the window and panes
See what sessions this person is involved in
Show file in File Explorer
View a file
Work with Custom Fields
Related Topics
Concepts overview

Add Files
1. Click the tab where you want to add the file.
2. In the left pane, click one of the following:
Project tab - Descriptive Documents or Other Documents
Sessions tab - the session
People tab - the person.
3. Do either of the following:
Drag and drop the file into area at the top of the right pane.
Click Add Files. In the Add Files dialog box, click the file you
want to add. Click Open.
The file is added in a new row.
4. If necessary, rename the file.
5. Enter file metadata.
Note
You add a file when you add a person's picture.
The View, Image or Video tab typically display controls or hyperlinks
you can use.
Each different file type has a different icon. See Symbols in the
Glossary of Terms.
Related Topics
Basic Tasks overview
Create Annotation file overview
Delete a file
Media Annotation overview
People tab tasks

Play a media file
Project tab tasks
Sessions tab tasks
View a file

Archiving overview
Recommendation: If possible, communicate with the archive you will
use before you start the project. What you are told can affect access
protocol choices, the way you prepare and deposit metadata with your
data, and so on.
SayMore can help get you ready to archive a session or archive the
project. You choose access protocol for the project and select access for
each session.
To aid with consistent and proper archiving, SayMore:
helps you name files in a way that identifies their relationship to a
session
organizes files into an easy-to-understand folder structure
uses a simple xml format to record metadata for people, sessions,
and the files you collected to document them.
SayMore:
collects all of the files in a session, all the files for the people you have
associated with a session (their metadata, informed consent files, and
so on), and project metadata.
creates a package that contains these files and metadata
pre-populates as much of the metadata as it can
opens RAMP, or saves the files in an IMDI package which you can
open in Arbil or another appropriate program.
Note
Reasons that you might want to archive sessions, instead of the whole
project, include (not exhaustive):
Individual sessions are typically 500Meg to 5 Gigs. That is already a
significant amount of data.
Early archiving is encouraged; do not wait until the entire project is
completed, which could be years after it is started.

When people do a search for the material, we want them to be able to
look for "Examples of preaching" or "Discussions" or "Children" and
so on, which relate to individual sessions. We do not want to force
them get the whole project.
Related Topics
Basic Tasks overview
How SayMore uses file names
Metadata (IMDI)
Metadata (RAMP)
User Interface terms overview

Change columns widths
To change the width of a column:
1. Hover your mouse pointer over the right edge of the column heading
until the pointer becomes a double-headed arrow ( ).
2. Click your mouse and drag that boundary until the column is the
width that you want. Then, release the mouse button.
Related Topics
Basic Tasks overview
Choose columns
Reorder columns

Choose columns
1. Click the

Sessions tab.

2. In the left pane, click the Choose Columns ( ) button.
3. In the drop-down list, select ( ) columns you want to display and
clear ( ) columns you want to hide.
4. Click anywhere outside of the drop-down list to close it.
Related Topics
Basic Tasks overview

Collaborating with other SayMore users
Currently, no SayMore User Interface (UI) features are available for
collaborating (programmatically sharing and synchronizing a project) with
other SayMore users.
However, a SayMore "database" is a collection of folders: Sessions,
People, OtherDocuments and DescriptiveDocuments. Each of these
contain files or subfolders with files for sessions, people and so on.
Show in File Explorer is one way to become familiar with where files
are (and should be) in the folder structure.

What can be done?
1. The person with an existing or newly created project can copy and
share the project folder with others who have the same version of
SayMore.
2.

As sessions, people and files are added to the project on each of the
computers, these files can be copied and shared (pasted in the right
place) with the other SayMore users with this project.
Collaborators can use removable USB devices or email to share the
files.
If this is done carefully and regularly, the copy of the project on each
person's computer can remain reasonably up-to-date.

Related Topics
Basis Tasks overview
Get more help
Tabs overview

Correct sound quality problems (Windows 10)
If you hear a poor sound quality from your recordings, one possible
solution is to disable the audio enhancements.
Your particular computer or audio system installation may be slightly
different, but here are the general steps:
1. Open Hardware and Sound on your computer's Control Panel.
2. Click the Sound link.
3. In the Sound dialog box, Recording tab, right-click your default
recording device and then click Properties.
4. Do one of these steps (depending on your computer and audio
system installation):
Click the Enhancements tab, and then select ( ) the Disable
check box.
Click the Advanced tab, and then clear ( ) the Enable Audio
enhancements check box (under Signal Enhancements).
5. Click OK.
Related Topics
Recording
Related Internet Sites
http://feedback.screencast-o-matic.com/knowledgebase/articles/693249microphone-voice-sounds-low-and-distorted-after

Customize file naming convention
We expect this to become more developed in a future version of
SayMore.
Currently, you are limited to a Custom Rename option when you rename
a file. Custom names do not change the stages of completion.
Related Topics
Basic Tasks overview

Delete a file
1. Click the tab that has the file.
2. In the left pane, click one of the following:
Project tab - Descriptive Documents or Other Documents
Sessions tab - a session
People tab - a person.
3. In the right pane, right-click the file, and then click Delete File.
The Confirm Delete dialog box appears.
4. Click

Delete.

Important
Every file has an associated *.meta file, which is used by SayMore.
The Delete File command deletes both the file and its *.meta file.
If you use Show the file in File Explorer and manually delete a file, you
must also manually delete the *.meta file.
See Also: Delete annotations.
Related Topics
Add files
Add/Change person's picture
Basic Tasks overview
Rename a file
Sessions tab tasks

View a file
The View tab preview ability is limited to *.pdf files and files that open
(can be viewed) in Internet Explorer (such as htm, html, xml, txt and lift).
So, you can view some added files in SayMore, but others must be
opened in the program associated with the file type.
If you cannot view a *.pdf file or another file that should open in Internet
Explorer (IE), you may need to research on the Internet why your IE does
not display it. For example, you may need to install or upgrade your
Adobe Reader®.
1. Click the tab that has the file.
2. In the left pane, click one of the following:
Project tab - Descriptive Documents or Other Documents
Sessions tab - a session
People tab - a person.
3. In the right pane, click the file.
The tab (View, Image or Video) displays the file contents or a
hyperlink you can click to open the file.
The Windows® File Download dialog box appears if the Always ask
before opening this type of file check box is selected ( ) in that
dialog box. Click the appropriate command to open or to cancel the
display of the file.
Play a media file has additional information.
Tip
You can clear ( ) the Always ask before opening this type of file
check box in the File Download dialog box. After you do this, you
may not see the dialog box again. If necessary, get more help or refer
to your computer's operating system Help system.
If the View tab does not display a

Folder structure describes where the files are stored.
Related Topics
Basic Tasks overview
Open it in the associated program
Tabs overview

Edit Stages
Currently, you cannot customize the list of stages. We expect this to
appear in a future version of SayMore.
Related Topics
Basic Tasks overview

Enter file metadata
1. Click the tab that has the file.
2. In the left pane, click one of the following:
Project tab - Descriptive Documents or Other Documents
Sessions tab - a session
People tab - a person.
3. In the right pane, click the file.
4. If a Properties tab appears, click it, and then do any of the following:
For video ( ) or audio ( ) files, click Presets, and then select
the device or microphone, if it has already been used in the
project.
Alternatively, do the following:
In a Device row, type or edit a distinguishing identification for
the device (video camera, recording equipment, and so on)
used to make the file.
In a Microphone row, type distinguishing identification
(microphone plugged into the input.
Click

More Information to see more information.

For other Field and Value columns, such as for image ( ) files, do
the following:
Click an empty Field column cell, and then type a new name
for the metadata you will type in the Value cell. Then, click the
Value cell and type the metadata. Repeat this for each kind of
metadata you need for the file.
Edit exiting Field or Value data.
If other rows appear, and are editable, enter or edit the metadata
for each cell as necessary.
5. If it appears, use the Contributors tab.

6. If a Notes tab appears, click it, and then type additional notes
about the file in a prose form (optional).
Tip
When you add files, different file types (image, audio, video,
document and so on) have different metadata. Typically, some
metadata that is specific to the audio or video file is automatically
added when create a new session from a device, or you extract the
audio from a video file. Such metadata is not editable, and appears
with a lighter font.
Contributors and Notes tabs only appear with parent files, not
subordinate files (example).
means the tab has existing content.
means the tab is empty.
Asterisks indicate that SayMore added a Warning to the
Notes tab, such as for an ambiguous date format in the metadata.
In this case, follow the instructions given in the Warning message.
Related Topics
Enter session metadata
Enter person metadata
FFmpeg
User Interface terms overview
Using Tools overview

Import metadata
Currently, you cannot import metadata. We expect this to appear in a
future version of SayMore.
Related Topics
Basic Tasks overview

Move or copy a project folder
By default, SayMore saves project data in a project folder in the SayMore
folder at
C:\Users\<you>\Documents\SayMore (Windows®).
You can:
move a project folder to another computer, or to another location in
your existing computer or to a USB Flash Drive or other external
drive; it does not need to be in the SayMore folder.
copy a project folder to another person's computer such as to begin
collaboration.

Move a project folder on your own computer
1. Exit SayMore.
2. Move or copy the project folder to the desired location.
3. Use

Browse for project the first time you open the project.

Copy and share a project folder with another computer
Person with project:
1. Exit SayMore.
2. Copy the project folder to a USB Flash Drive or other external
drive that you can share.
Recipient of the drive with the project folder:
1. Copy the project folder to the desired location.
2. Use

Browse for project the first time you open the project.

Note
Do not move (or rename) folders that are inside your main project
folder.
You could make a desktop shortcut to the <name>.sprj file and launch

the project from that shortcut. (Refer to your Operating System's Help
system.)
Related Topics
Basic Tasks overview
Collaborating with other SayMore users
Get more help
Rename file

Multiple consent forms
We expect this to appear in a future version of SayMore.
Related Topics
Basic Tasks overview
Informed Consent

Open in Program Associated with this File
1. Click the tab that has the file.
2. In the left pane, click one of the following:
Project tab - Descriptive Documents or Other Documents
Sessions tab - a session
People tab - a person
3. In the right pane, click the file, and then do either of the following:
Right-click the file, and then click Open in Program Associated
with this File.
Click Open , and then click Open in Program Associated with
this File.
Another window opens to display the file in the program associated
with that file type (picture, video, text file, and so on).
You can now edit the file (if it is editable).
Related Topics
Basic Tasks overview
Play a media file
Sessions tab tasks
Show in File Explorer
View a file

Play a media file
1. Click the tab that has the media file.
2. In the left pane, click one of the following:
Project tab - Descriptive Documents or Other Documents
Sessions tab - a session
People tab - a person.
3. At the top of the right pane, click the media file.
The file appears in the bottom portion of the right pane, in a Video
or Audio tab. The file and associated annotation files may appear
in a Annotations or Generated Audio tab.
4. In the bottom of the
button.

Video or Audio tab, click the

(play)

Note
After you click

(play), the button changes to

(pause).

(stop) - click to stop the playback.
(volume) - click the down arrow to use the volume slider.
(progress) - slide forward or backwards to move ahead or move
back in the playback progress.
The lower right corner shows the current time played and the total
duration of the file.
Example:
.
See Also: Working with annotations.
Related Topics
Annotations tab overview
Generated Audio tab overview

Tabs overview
View a file

Recording
SayMore allows you to make a recording using a Session Recorder
dialog box. When you close this dialog box, a new session is
automatically added and the recording added to it. Add a session from a
new recording provides the steps.
Related Topics
Basic Tasks overview
Correct sound quality problems (Windows 10)
Related Internet Sites
http://audacity.sourceforge.net/
http://en.wikipedia.org/wiki/Audacity
http://software.sil.org/saymore/news/

Rename a file
1. Click the

Sessions or

People tab.

2. In the left pane, click the session or person that has the file you will
rename.
3. In the right pane, click the file, and then click Rename.
The Rename dialog box opens.
4. Do one of the following in the dialog box:
In the Change Name To box, type the term you want to add to
the file name, such as Source, Consent, Careful, and so on. Click
Rename.
Below Shortcuts, click the link that describes how you want to
rename the file. Click Rename.
The file name (and the associated *.meta file) changes.
Related Topics
Basic Tasks overview
How SayMore uses file names
Sessions tab tasks
Stages of completion

Reorder columns
In the left pane of the

Sessions tab, you can reorder the columns:

Click and hold the column header for the column you want to move,
and then drag the mouse pointer to the location where you want to
column. Release the mouse button.
Related Topics
Basic Tasks overview
Change column widths
Choose columns
Sort columnar data

Resizing the window and panes
To change the size of an entire SayMore window, click and drag any
edge of the window until the window is at the desired size.
To change the width or height of an individual pane, hover the mouse
pointer over a line between the panes until the pointer becomes a line
with outward pointing arrows, such as
or . Then, click and hold
the mouse button, and drag that edge until the pane has the desired
width or height.
Tip
Typically, a scroll bar appears when a pane is too narrow or short to
fully display all the content in that pane.
Related Topics
Basic Tasks overview
User Interface overview
Using Tools overview

See what sessions this person is involved in
We expect this to appear in a future version of SayMore.
Related Topics
Basic Tasks overview

Show in File Explorer
Normally, when you add a file as project metadata or to a session or
person, you do not need to work with that file in your computer's file
explorer. But if you need to, do the following:
1. Click the tab that has the file.
2. In the left pane, click one of the following:
Project tab - Descriptive Documents or Other Documents
Sessions tab - a session
People tab - a person
3. In the right pane, click the file, and then do either of the following:
Right-click the file, and then click Show in File Explorer.
Click Open , and then click Show in File Explorer.
A window opens and displays the contents of the folder that has the
file.
Important
In general, do not manually change the name of a file. If it is
necessary, it is critical that you also rename the associated *.meta file.
See: Rename file.
If you delete the file, delete the *.meta file too. See: Delete a file.
Related Topics
Add files
Basic Tasks overview
Open in Program Associated with this File
Sessions tab tasks

Sort columnar data
In the

Sessions and

People tabs, data is presented in columns.

You can choose which columns to display in the Sessions (left) pane of
the
Sessions tab. In some cases, you can reorder the columns. Also,
in some cases, you can sort data on a particular column.
To sort data on a column, do the following:
Click the column header that has the data on which you want to base
the sort of the table.
To reverse the sort order, click that same column again.
Note
You cannot set a secondary or tertiary sort order.
Related Topics
Basic Tasks overview
Sessions tab tasks

Work with Custom Fields
In Custom Fields, the intersection of a row and column is a cell.

Enter Custom Field metadata
1. Click an empty cell in the Field column, and then type a descriptive
label for what you will type in the Value field.
2. Click the Value column cell in that row, and then type the metadata.
3. If necessary, use the Notes tab to record a longer description of
this custom metadata.

Edit existing Custom Field metadata
1. Click the cell that has content that you will edit.
The contents in that cell are fully selected.
2. Click again to put the insertion point (blinking line) where will edit.
3. Edit that content.

Replace contents in a cell
1. Click the cell that has the contents you want to replace.
The contents in that cell are fully selected.
2. Type the new contents.

Delete an entire row
1. Select all the contents in the Field column for that row.
2. Press the Delete or Backspace key, and then click anywhere
outside of that cell.
The Confirm Delete dialog box appears.
3. Click

Delete.

Related Topics

Custom Fields
Basic Tasks overview
Enter person metadata
Enter session metadata

Project menu overview
Menu Command

Use to

Open/Create
Project

Open a project or Create a new SayMore
project

Export Sessions

Export Sessions

Export People

Export People

Archive using IMDI

Archive (Project) using IMDI

Change User
Interface Language

Change User Interface Language
Using the Localize User Interface dialog
box
Share a UI language file

Exit

Exit (close) the SayMore program.

Tip
There is no Delete command that deletes a project. Instead, you can
delete the project folder in your Windows Explorer (File Explorer).
Related Topics
Menus overview
Localizing Access Protocol Information
Shortcut Keys overview

Archive the project
This topic is intended for archiving using IMDI (to TLA). For other
archives, you must communicate with them to learn what you need to do.
1. Make sure all these metadata are as complete and accurate as
possible:
Project metadata.
Session metadata (particularly the Access selection) for each
session.
Person metadata.
File metadata.
2. On the Project menu, click Archive using IMDI.
If this is the first archive activity since the project was moved or
copied, an error message will appear and state that the path was not
found. Click OK.
The SayMore: Archive using IMDI dialog box opens.
Warnings appear in a blue font; Errors appear in a red font.
3. To archive only the metadata, select ( ) the Metadata only check
box.
4. To choose a different location for the IMDI package, click the
Change Folder link. Then browse for the desired folder.
5. Click Create Package.
These messages appear:
Saving files in IMDI package.
Exported to <name>.imdi. This path is now on your clipboard. If
you are using Arbil, go to File, Import, then paste this path in.
5. Click Close.
6. To continue, use Arbil or another similar program.

Related Topics
Access protocol
Archiving overview
Project menu overview

Change User Interface Language
1. On the Project menu, click Change User Interface Language.
The User Interface Language dialog box opens.
2. In the dialog box, click the Language down arrow, and select a
language.
If the language you need is not listed, or you need to edit
translated UI content, click the I want to localize SayMore for
another language hyperlink.
The Localize User Interface dialog box opens so you can use it.
Optionally, get a shared UI language file and a translated Access
Protocol file from another user.
3. Click OK.
See Also: Localizing Access Protocol Information.
Related Topics
Change language
Project menu overview
User Interface terms overview
Using the Localize User Interface dialog box

Create a new SayMore project
1. On the Project menu, click Open/Create Project.
The SayMore dialog box appears.
2. Click

Create new, blank project (below Create).

The New SayMore Project dialog box appears.
3. Type the name you want to call the project.
This name appears as the initial project title in the Project tab. You
can edit it in the Title field. This will not change any project files or
folder names.
The path to the project folder appears and updates as you type the
name.
4. Click OK.
The new project opens in SayMore, typically to the Project tab.
Note
In the SayMore dialog box:
Below Open is a list of projects that have been open recently.
Use

Browse for project to find any additional projects.

Version data and links to the SIL and SayMore Internet sites appear
at the bottom.
Related Topics
Folder structure
Project menu overview
Tabs overview

Exit
On the Project menu, click Exit.
The SayMore window closes.
Related Topics
Project menu overview
Shortcut keys overview

Export Sessions
To export all of the sessions and associated data in the open project to a
file, do the following steps:
1. Open the project that has the session data you want to export.
2. On the Project menu, click Export Sessions.
The Export Data dialog box appears.
3. In the dialog box, click the File name box, and then type a name.
Leave the Save as type selection as CSV (Comma delimited)
(*.csv). Also, it is recommended that you save the file in the project
folder, which is the default location.
4. Click Save.
The session data in the open project is exported to a file.
5. To open the file, open the folder, and then double-click the file.
The export file opens with the program specified as the default
program for the file type.
(Refer to your Windows operating system Help for details.)
Related Topics
Archive Project
Project menu overview

Export People
To export all of the people and associated metadata in the open project to
a file, do the following steps:
1. Open the project that has the people you want to export.
2. On the Project menu, click Export People.
The Export Data dialog box appears.
3. In the dialog box, click the File name box, and then type a name.
Leave the Save as type selection as CSV (Comma delimited)
(*.csv). Also, it is recommended that you save the file in the project
folder, which is the default location.
4. Click Save.
The people data in the open project is exported to a file.
5. To open the file, open the folder, and then double-click the file.
The export file opens with the program specified as the default
program for the file type.
(Refer to your Windows operating system Help for details.)
Related Topics
Archive Project
Project menu overview

Localizing Access Protocol Information
When you chose an access protocol, SayMore displays information about
that protocol such as descriptions of the access choices it offers.
The Localize User Interface Items dialog box cannot localize Access
Protocol information. The reason is that this information is not in
individual text strings that are independently localizable. Instead, these
are stored in HTML files (such as reap.html) which are installed with
SayMore.
Advanced users can localize text in a copied HTML file as following:
1. Make a note the locale ID of the target language.
To find the IDs for existing localized versions of SayMore, look at the
*.tmx files which are typically in C:\Program Files (x86)\SayMore.
The ID is the portion of the file name between the two periods. For
example, SayMore.es.tmx is Spanish (Español).
2. Open the Archiving folder in the folder where SayMore is installed.
This is typically C:\Program Files (x86)\SayMore\Archiving.
3. If there is not already a sub-folder named with the locale ID of the
target language, create a folder using the ID as the folder name.
See the existing es folder for an example.
4. Copy one or more existing access protocol HTML file (such as
reap.html) that you want to localize. Paste them in the folder you
created in step 3.
If the folder already existed, be careful not to accidentally overwrite
any existing localized HTML file. You can copy the original English
version or any existing localized version of the file(s) to use as a basis
for your new localized version.
Do not change the names of these files.
5. Open a copied file using an HTML editor or plain text editor.
6. Translate only the text that appears in SayMore. Be careful to not

change the formatting tags.
7. Save the file(s).
8. Verify the translated information appears correctly:
Start SayMore.
Change the User Interface language to the applicable language.
Click the Project tab, and then click Access Protocol.
Read the translated information. Edit the file again, if necessary.
9. To get your translation work into the next version of SayMore, e-mail
your translated HTML file(s) to:
issues@saymore.palaso.org
If you cannot wait for the next version of the SayMore, you can still
share your localization with others. Put a copy of the localized
subfolder with the HTML files into the Archiving folder on their
computers.
Note
Only languages that have translated UI strings will appear as choices
in the User Interface Language dialog box. If you have translated the
Access Protocol HTML files into a particular locale, at least some of
the UI must also be translated into that locale in order to be able to
select it as the UI language.
Related Topics
Change User Interface language
Localize User Interface dialog box, using the
Share a UI language file

Open Project
1. On the Project menu, click Open/Create Project.
The SayMore dialog box appears with a list of recently-open projects
(below Open).
Use

Browse for project to find other projects.

2. Do one of the following to open a project:
Click the project you want to open.
Click Browse for project, find the project you want to open,
and then click Open.
Tip
If you hover your mouse pointer over a project name in the SayMore
dialog box, a pop-up tool tip appears. It displays the path (URL) to the
project. Notice that projects are <name>.sprj files.
You could make a desktop shortcut to the <name>.sprj file and
launch the project from that shortcut. (Refer to your Operating
System's Help system.)
The SayMore dialog box shows the SayMore version number and
build date. Include them when you get more help.
See Also: Folder structure and Move or copy a project folder.
Related Topics
Create new, blank project
Project menu overview

Share a UI language file
When you use the Localize User Interface dialog box, a *.tmx file is
updated or added here:
C:\Users\<you>\AppData\Local\SIL\SayMore (Windows®)
Each *.tmx file stores user interface labels (terms, and so on) for a
localization language. The file name includes the language identifier,
such as SayMore.fr.tmx where fr is French.
You can contact other users to learn if they have UI language files to
share.
Do the following share a localization file:
1. Send or receive a copy of a *.tmx file in any of these ways:
As an e-mail attachment.
Use a drop-box or a shared network folder.
Use a shared USB Flash Drive (or similar).
2. Recipients of a *.tmx file need to do the following:
Paste a copy of that file into their SayMore folder.
Start SayMore.
Change User Interface language to that UI language.
Important
In the Localize User Interface dialog box, the How to distribute
your translation work link opens the How To Distribute dialog box.
It has:
a link to the folder with the *.tmx files, and
the email address (issues@saymore.palaso.org).
You can send a *.tmx file you've completed. It can be included in future
versions.

If you have custom localization work that you want to use but not
share, keep a separate copy of your customized *.tmx file
somewhere. Then, replace the one that is installed, if any, when you
install subsequent versions of SayMore.
In previous versions, the files were kept here:
C:\ProgramData\SIL\SayMore. A file you started may still be there. If
necessary, copy that file from this location to the new one (above).
Localizing Access Protocol Information describes how to share
localizations of Access Protocol information.
Related Topics
Localizing Access Protocol Information
Project menu overview

Using the Localize User Interface dialog box
1. Do one of the following to open the Localize User Interface dialog
box:
In the User Interface Language dialog box, click the hyperlink I
want to localize SayMore for another language.
To open it to a particular instance of a UI term (item), press
Alt+Shift and click the item in the user interface (UI). The term
must be available (not grayed-out).
2. In the title bar (right pane), select the Source Language and Target
Language.
3. In the Groups pane, click a group, or a particular item if it is not
already selected.
As needed, expand ( ) or collapse ( ) nodes (have plus- or
minus-sign boxes).
When a node is selected in the left pane, the right pane shows a grid
with each field as a row. The columns show UI items in the
languages you selected on the title bar, and a Comment column.
For the target language, the intersections of columns and rows are
editable cells.
When an item is selected in the left pane, the right pane has the
Item Identifier. Below it are boxes (places) where you can type or
paste.
4. If you clicked a node, click a row in the right pane that needs
translation work.
5. Do one of the following:
Type or paste one or more translations, and a comment about the
translations (optional).
If you have an internet connection, click the Bing down arrow
, and then click one of the following:
Translate using Bing

The translation is added to that row. Edit a translation words if
necessary.
Edit Source & Translate Using Bing to open the Edit
Source Before Translating dialog box. Then, do the
following:
Click the Translate From <source> to <target language>
button.
As needed, edit the source language text in the top portion
of the dialog box, and then click the button again to see a
new translation.
When you are satisfied with the translation, click Copy
<target language> Text of Clipboard and Close.
Paste the clipboard contents into the grid cell or box where
this translation needs to be added.
6. Repeat any of the steps above as necessary.
7. Click OK.
8. Optionally, localize the Access Protocol information.
9. Share a UI language file with other users (optional). Click the How to
distribute your translation work link for more information.
Related Topics
Change User Interface language
Project menu overview
User Interface terms overview

Session menu overview
When the

Sessions tab is selected, the Session menu is available.

Menu Command

Use to

New

Add a empty session.

New From Device

Add a session and pull data and metadata
from a recording device.

New From
Recording

Open the Session Recorder so you can add
a session by making a new recording.

Archive With
RAMP

Archive a session with RAMP (SIL).

Archive using IMDI

Archive a session using IMDI.

Delete Session

Delete the current session.

Related Topics
Menus overview
Shortcut Keys overview

Archive a session
This topic is intended for archiving a session with RAMP (to REAP) or
using IMDI (to TLA). For other archives, you need to communicate with
them to learn what you need to do.
1. Make sure all these metadata are as complete and accurate as
possible:
Project metadata.
Session metadata (particularly the Access selection) for each
session.
Person metadata.
File metadata.
2. Click the

Sessions tab.

3. In the Sessions (left) pane, click the session.
4. Right-click that session or click the Session menu, and then click
Archive with RAMP (SIL) or click Archive using IMDI.
If this is the first archive activity since the project was moved or
copied, an error message will appear and state that the path was not
found. SayMore will offer you a new path with the option to change to
that path.
The SayMore: Archive using RAMP (SIL Only) or the SayMore:
Archive using IMDI dialog box opens.
Do the following in the SayMore: Archive using RAMP (SIL Only)
dialog box:
1. Click 1) Create Package.
A temporary package (deleted after RAMP receives it) is created.
2. If Ready to hand the package to RAMP appears, click 2) Launch
RAMP.

The RAMP program starts.
3. Follow the steps in the RAMP window.
Do the following in the SayMore: Archive using IMDI dialog box:
1. If necessary, click the Change Folder link to choose a different
location for the IMDI package.
2. Click Create Package.
These messages appear:
Saving files in IMDI package.
Exported to <name>.imdi. This path is now on your clipboard. If
you are using Arbil, go to File, Import, then paste this path in.
3. Click Close.
4. Use Arbil or a similar program to continue.
Related Topics
Access Protocol
Archiving overview
Export a session
Sessions tab description
Sessions tab tasks

Person menu overview
When the

People tab is selected, the Person menu is available.

Menu Command

Use to

New

Add a new person.

Delete Person

Delete the person currently selected in the
People (left) pane.

Related Topics
Menus overview
Shortcut Keys overview

Help menu overview
Menu
Command

Use to

Release Notes

Open the Release Notes.

Help

Open these SayMore Helps.

About

Open the About SayMore dialog box.
Include your version number and build date
when you get more help or report a bug.

Related Topics
Menus overview
Shortcut Keys overview
Related Internet Sites
http://software.sil.org/saymore/

Menus overview
The menu bar appears below the title bar.

Project (always available)
Session (available when the
Person (available when the

Help (always available)
Related Topics
Shortcut Keys overview
Tabs overview
User Interface overview

Sessions tab is selected)
People tab is selected)

Tabs overview
The main SayMore window has three tabs:

Project
Project
Project tab description
Project tab tasks
Project tab User Interface terms
About This Project - UI terms

Sessions
Session
Sessions tab description
Sessions tab tasks
Sessions tab User Interface terms
More Fields
Custom Fields

People
Person and contributor
People tab description
People tab tasks
People tab User Interface terms
Custom Fields
Related Topics
Basic Tasks overview

Shortcut Keys overview
User Interface terms overview
User Interface overview
Using Tools overview

About This Project
Click the

Project tab, and then click About This Project.

Enter brief and concise information. For longer pieces of project
metadata, add Descriptive Documents or Other Documents.
Project
Basics

Description

Title

The full title for the project. Initially, the project name
appears here. You can edit it, such as to make it more
formal (longer). This will not change the project name,
or any file or folder names.

(Languages)

You see the ISO-639 name of the languages used in
the sessions. They appear above the Content
Language and Working Language hyperlinks.
The links open the Lookup Language Code dialog
box. See: Change Language.

Description

Information about the scope and goals of the project.

Contact

The name of the person responsible for the project.

Main
Location

Description

Address

The location, such as the village, town, address or GPS
coordinates where the session was recorded or
originated.

Region

The region or sub-region that has the location or address.

Country

A closed (controlled) vocabulary list which is used to
identify the country where the location/address and
region are located.
If you choose the blank item in the drop-down list and
type in a new country name, that country will not be
available as a value you can select in the Location

Country drop down list in More Fields.
Continent

A closed (controlled) vocabulary list which is used to
identify the continent that has the country.

Responsibilities

Description

Funding Project

A title that matches associated project funding
documentation.

Available On

The date of that this project was or will be
archived.

Rights Holder

The person holding the copyright.

Depositor

The person responsible for depositing the
resource in an archive.

Important
The Working Language is usually a Language of Wider
Communication. It is used, for example, for Free Translations in
annotations and in Written Translations.
For more information, see:
http://tla.mpi.nl/wp-content/uploads/2012/06/IMDI_MetaData_3.0.4.pdf
See Also: More Fields.
Related Topics
Enter project metadata
User Interface terms - Project tab
User Interface terms overview

Custom Fields
Custom Fields appear in the Session tab (more) and Person tab
(more). Use them to capture metadata for which SayMore has no
dedicated field.
Below Custom Fields you see a Field column and a Value column. A
cell is the intersection of a column and a row.
In each row, the cell in the Field column stores your descriptive label
for the Value column contents.
The information in the cells must be brief. No vertical scroll bars will
appear and the strings of text will not wrap.
Use a Notes tab for longer chunks of prose information, which could
include longer descriptions of your custom field metadata.
Work with Custom Fields helps you enter, edit and delete custom field
content.
Note
ELAR Topic and ELAR Keyboard are two custom field
Related Topics
Concepts overview
Enter person metadata
Enter session metadata
Tabs overview

More Fields
In the
Sessions tab, the Session tab displays More Fields. These
fields and their values are IMDI metadata elements for session
descriptions. See Also: User Interface terms - Sessions tab.
Location project metadata are copied to corresponding Location
fields (below) when you add a session.
Term

Description

Researcher
Involvement

Select one of the following:
<blank> - unknown or unspecified.
Elicited - Investigator asks speaker(s) to
produce isolated phonemes/ words/
utterances/grammatical structures.
Non-elicited - The researcher does not interfere
verbally with the speech event (other than the
researcher's mere presence).
No observer - No outside observer is present.

Location
Country

A closed (controlled) vocabulary list of country
names is used. Select one.

Location
Continent

A closed (controlled) vocabulary list of continent
names is used. Select one.

Location
Region

The region or sub-region of where the session was
recorded or originated. Type the region or subregion.

Location
Address

The address where the session was recorded or
originated. Type the address.

Planning
Type

A closed (controlled) vocabulary list from which you
can choose Spontaneous, Semi-spontaneous or
Planned to indicate how this session came to
happen.

Sub-Genre

The conventionalized discourse sub-types of the

content of the session. Type the sub-genre. See
also: Genre.
Social
Context

Select one of the following:
<blank> - unknown or unspecified.
Family - The access to the communication event
is restricted to relatives.
Private - The access to the communication event
is restricted to specific individuals of the social
environment.
Public - The access to the communication event
is allowed to whoever, in a free or in a regulated
manner.
Controlled Environment - The access to the
communication event undergoes the agreement
to elicit a linguistic behavior.

Important
For more information, see:
http://tla.mpi.nl/wp-content/uploads/2012/06/IMDI_MetaData_3.0.4.pdf
Related Topics
Arbil
Concepts overview
Metadata (IMDI)

People tab description
Use the
People tab to collect information (enter person metadata)
about each person who participated in a session.
It is not necessary to exhaustively record metadata for individuals who
only contribute, such as by operating equipment. However, for anyone
who participates (whose voice is recorded, makes a written transcription,
and so on) it is critical to collect basic background information like age,
gender, level of education, location where they first learned the language,
first language of both parents, and so on.
With the People tab selected, the People (left) pane shows a list of
people by name or code. The Consent column indicates the informed
consent availability.
Click a person in this pane to display data and files in the right pane.
The top portion of the right pane shows rows of files that have been
added for the person. Columns describe those files, such as date
modified, size and type.
When you click a row, the bottom portion of the pane shows tabs that
are appropriate for the file type. User Interface terms - People tab and
other topics describe them.
You select people as part of session metadata. If you edit the name or
code of a person in the People tab, it is automatically updated in all
instances where the person was selected.
Related Topics
People tab tasks

Project tab description
Use the
Project tab to collect information (enter project metadata)
that concern the entire project.
About This Project has fields for the project title, description, location
and so on.
Access Protocol has the control you use to specify the choices you
want available in the Access control which is used when you enter
session metadata.
Description Documents is where you add document files that
describe the project and corpus.
Other documents is where you add any other project-level
documents that do not belong in Description Documents.
Progress displays progress data you can review and then copy, save
or print.
Note
These metadata and documents added are critical for the discoverability
and use of the archive.
When you archive with IMDI:
Files in Descriptive Documents are exported to a special session
named Project Descriptive Documents.
Files in Other Documents are exported to a special session named
Other Project Documents.
Related Topics
Access Protocol
Project tab tasks
Tabs overview
User Interface terms - Project tab

Sessions tab description
In the

Sessions tab, you work with the sessions in the project.

Left pane
The Sessions pane has a grid (rows and columns) that displays all
the sessions in the open project.
New, New From Device, and New From Recording buttons
appear at the bottom of this pane so you can add sessions. The
Session menu also has these commands.

Right pane
Top Portion
Session files ( ) and all associated files you have added appear in a
grid.
Metadata appears in these columns: Name, Type, Date Modified,
Size, and Duration.
The left-most column has a icon that is appropriate for the file
type. The Type column gives type and subtypes.
Some files can have subordinate files (example).
In such cases, only the parent file has a
Contributors tabs.

Notes and

Bottom Portion
For each type of file selected in the top portion of the pane, different
tabs are displayed. Here are some examples (not exhaustive):
Tabs / Type of Selection

(Session)

Session

Status
&
Stages

Y

Y

Video

Audio
or
Generated
Audio

Annotations

(Video)
(Audio)
(OralAnnotations)
(Annotations)

Y
Y
Y
Y

(Image)
(pdf)
Note
Audio tab appears when the selected file shows Audio in the Type
column. You can play that file.
Generated Audio appears when a <name>.
<type>.oralAnnotations.wav file is selected (OralAnnotations in the
Type column). This tab displays and enables you to play Careful
Speech and Oral Translation annotations.
See Also: Sessions tab tasks and User Interface terms - Sessions tab.
Related Topics
Concepts overview
ELAN
Enter file metadata
Open in Program Associated with this File
Tabs overview
Using Tools overview

User Interface terms overview
User Interface (UI) terms (labels) that you see in each of the tabs
(column headers, boxes, fields, and so on), are described in the following
topics.
Project tab - UI terms
Sessions tab - UI terms
People tab - UI terms
These tabs appear on the Sessions and People tabs:
Properties tab - UI terms
Contributors tab - UI terms
Note
The labels generally reflect IMDI standards, such as described here:
http://tla.mpi.nl/wp-content/uploads/2012/06/IMDI_MetaData_3.0.4.pdf.
You can change or localize the UI language yourself. Also, you can
share UI language files.
Many terms are similar to the BOLD (Basic Oral Language
Documentation).
Related Topics
Concepts overview
Custom Fields
Enter session metadata
Enter file metadata
More Fields
Symbols (in Glossary of Terms)
User Interface overview

Related Internet Sites
https://www.ethnologue.com/

User Interface terms - Contributors tab
When you click certain files in the
Sessions tab or
People tab, a
Contributors tab appears. Use it to collect metadata about contributors
and their contribution to that file and any files that are subordinate to it.
Column
Header

Description

Name

The full name of a contributor.

Role

The role of the contributor towards this language
documentation effort, not their social role. Choose the
role from a drop-down list of roles.

Date

The date of this contribution.
You can click the date on a drop-down calendar, or
click and edit the displayed date.

Comments

Any brief information needed to distinguish or inform
the reader about the contributor or contribution.
Deletes the current row.

Related Topics
Change the User Interface language
Enter file metadata
Role list sample
User Interface terms overview

User Interface terms - People tab
The labels generally reflect IMDI standards, such as described here:
http://tla.mpi.nl/wp-content/uploads/2012/06/IMDI_MetaData_3.0.4.pdf.
In the
People tab, when you click a <name>.person file at the top of
the right pane, a Person tab is displayed:
Person tab
Term

Description

Full Name

Type the full name of the person. A warning box ( )
appear if you have more than one person with the
same name. You may need to include a middle initial
or some other distinguishing addition.
The Full Name is used as the name of the folder that
stores the files associated with the person.
The Code (below) may replace the full name.

Birth Year

Type the birth year with 4 digits (YYYY).

Nickname

Type another name by which the person is commonly
known. It is used only by the IMDI archive.

Code

Optionally, type a short unique code to identify the
person. If there is a code for the person, it is used
instead of the Full Name, such as in the Person
column (People pane) and People drop-down list
(more). Currently, this code will not be included in the
IMDI export.

Gender

Select Male or Female.
A placeholder where you can add a picture.

Primary
Language

Type the language the person speaks most often; if
possible, enter the Ethnologue code of the language.
Click

/

or

/

to indicate if the language is

also the primary language of the father or mother.
Learned In

Type where the person learned to speak the language,
such as which village or other meaningful location that
would account for the persons speech characteristics.

Other
Languages

Type other languages the person speaks; if possible,
enter the Ethnologue code of the language.
Click
/
or
/
to indicate if the language is
also the primary language of the father or mother.

How to
Contact

Type an address, phone number, email address and
any other means of contacting the person.

Education

Type a keyword-like indication (recommended).
Indicate the highest completed level of education and
any other relevant education, such as could indicate
the literacy of the person. Due to many expected
differences this element is not constrained.

Ethnic
Group

Type the ethnic group of the person participating in the
session.

Primary
Occupation

When appropriate, type the main job that provides the
person's income, such as Subsistence farmer.
Alternatively, or in addition, indicate that the person is
a mother, a child, unable to work (disabled), and so
on (as appropriate).

Custom
Fields

Custom fields allow you to capture metadata for which
SayMore does not provide a dedicated field.

——————

——————

People pane

The People pane is on the left side of the SayMore
window.
The Person column lists the full name or code of
each person.
The Consent column shows a warning icon ( ) if

there is no consent document and tablet icon ( )
when there is one.
Note
The Contributions tab lists sessions that the current person was also
a contributor. See: Use Contribution tab.
The information gathered about the person should be as linguistically
relevant as possible. For example, the person's place of birth may not
be linguistically relevant because the person may have moved very
soon after birth.
Related Topics
Change the User Interface language
Enter person metadata
People tab description
User Interface terms overview
Related Internet Sites
https://www.ethnologue.com/

User Interface terms - Project tab
User Interface terms are discussed in these topics:
About This Project
Access Protocol and Choose Access Protocol
Enter project metadata (for Descriptive Documents and Other
Documents)
Review progress data
Concepts topics such as Stages of completion and Genre.
The terms in labels generally reflect IMDI standards, such as described in
http://tla.mpi.nl/wp-content/uploads/2012/06/IMDI_MetaData_3.0.4.pdf.
Related Topics
Change User Interface language
Concepts overview
Project
Project tab tasks
User Interface terms overview
Related Internet Sites
https://www.ethnologue.com/
https://www.help.insitehome.org/reap/manual/ramp-users-manual

User Interface terms - Properties tab
Fields you see in the Properties tab when a media (audio or video) file is
selected (Sessions tab or People tab) are listed in the tables below. See:
Enter file metadata.
Audio and Video
Term

Description

Device

Distinguishing name/model/Id of the device plugged
into the input.
It will appear in Presets drop-down list.

Microphone

Distinguishing name/model/Id of microphone
plugged into the input. For example, Olympus
ME53M Lavalier. Or, it could help identify a "build-in"
mic if part of a device, such as a video camera.
It will appear in Presets drop-down list.

Duration

Length of recording, usually in H:M:S
(Hours:Minutes:Seconds).

Channels

Mono, stereo, or other.

Bit Depth

Audio bit depth is a number (like 16 or 24) which
states how precisely the loudness of a signal can be
recorded (dynamic range). Most recordings today
should be done at 24 bits.

Sample
Rate

The number of times per second that a sound wave
is measured. A higher sampling rate provides a more
faithful reproduction of the sound. The current
acceptable standards are 44khz or 48khz; 96khz is
considered ideal, as it will facilitate future noisereduction processes.

Audio Bit
Rate

Usually stated in kbps (kilobits per second), the
number of bites per unit of time.

Video only
Term

Description

Video Bit
Rate

Usually stated in kbps (kilobits per second), the
number of bites per unit of time.

Resolution

The degree of sharpness of a computer-generated
image as measured by the number of dots per linear
inch in a hard-copy printout or the number of pixels
across and down on a display screen. Examples: 176
x 144, or 800 x 600.

Frame
Rate

Frames per second.

Note
If you click More Information, a window opens with additional
information. It is beyond the scope of these SayMore user Helps.
Most of these metadata fields are automatically filled when you use
FFmpeg. In this case, the fields are not editable but you can read the
contents in them.
Related Topics
Change the User Interface language
Custom Fields
User Interface terms overview
Related Internet Site
http://www.digitizationguidelines.gov/term.php?term=bitdepthaudio
http://www.digitizationguidelines.gov/term.php?term=samplingrateaudio
http://en.wikipedia.org/wiki/Bit_rate

User Interface terms - Sessions tab
The labels generally reflect IMDI standards, such as described here:
http://tla.mpi.nl/wp-content/uploads/2012/06/IMDI_MetaData_3.0.4.pdf.
In the
Sessions tab, when you click a Session file (type), the
Session tab is displayed. This table lists words that you see in that
tab.
Session
tab term

Description

Id

Use your own coding system, unique for each
speech session. However, if the session is related to
others, say, as different parts of the same overall
recording opportunity or as a continuation of another
filled-up Session Worksheet, then the number should
reflect that. Example: dWR09-04A-am; dWR09-04Apm-2.
Note: The Id is used as the name of the folder that
stores the files associated with the session, and is in
the file name of renamed files.

Date

Select the date when the session recorded or
originated.

Title

Type the title you want for the session. Example:
Emir Hussein’s Wedding 2014. (You type the project
title in About This Project.)

Setting

Type the location where the session occurred from a
more cultural standpoint. Examples: ”In X’s home”;
”Outside the church”; ”Beside the river”.

People

Select people (by name or code) whose voice is
recorded or who made written transcripts and similar
(more). This is not those who operated equipment or
contributed to a file.

Location

Type the location, such as the village or town, where
the session was recorded or originated.

Genre

A genre is a class or category of a session having a
particular form, content, technique, and so on. (From
http://tla.mpi.nl/wpcontent/uploads/2012/06/IMDI_MetaData_3.0.4.pdf:
"The conventionalized discourse types of the content
of the session." More Fields has Sub-Genre field.)
Choose from the drop-down list or type a new
genre directly in this field.

Access

Select the access level for the current session.
Available choices are based on the choice made in
the Access Protocol area of the Project tab.

Situation

Type any details that seem relevant about the context
for the session or the course of events that caused
the session to take place.

Description

Type the scope and goals of the session.

More
Fields

See: More Fields.

Custom
Fields

Custom fields allow you to capture metadata for
which SayMore does not provide a dedicated field.

Status & Stages displays controls you can use. See: Status &
Stages tab overview and Stages of completion.
Notes allow you to type notes about the file. See: Enter Session
Metadata and Enter file metadata.
If you click an added file, other tabs appear. Sessions tab description
and this table describe those terms:
Tab label

Description

Related Topics

View

Shows metadata in an xml
format, or can display the
contents of the file, such as

View a file

a PDF file.
Image

Shows the current picture.

View a file

Audio

Displays controls so you
can play the current audio
file.

Play a media file

Video

Displays controls so you
can play the current video
file.

Play a media file

Annotations

Displays controls so you
can work with annotations.

Annotations tab
overview

Generated
Audio

Shows controls so you can
play the current audio file.

Generated Audio
tab overview

Properties

Shows fields and values,
typically populated by
added media files. The
More Information button
shows more file metadata.

Contributors

Shows contributors, roles
and more.

Use Contributors
tab

Start
Annotating

Displays controls so you
can start annotating.

Create Annotation
file

Related Topics
Change the User Interface language
Choose columns
Metadata (RAMP)
Metadata (IMDI)
User Interface overview

Shortcut Keys overview
Function Keys
When you work with annotations, press F2 if you need to replay the
current segment.

Zoom controls in Manual Segmenter dialog box
When you use the Manual Segmenter dialog box, these shortcut key
combinations are available:
Ctrl+1 zooms in on the horizontal axis of the audio, which displays
more detail but a shorter length of time.
Ctrl+2 resets the zoom to about one inch per second. The Zoom
control is set to 100%.
Ctrl+3 zooms out, which displays less detail but a greater length of
time.

Alt+Shift - localize User Interface (UI)
To open the Localize User Interface dialog box to a particular UI
term (label), press and hold the Alt+Shift keys and then click it.

Alt Keys
You can press the Alt key, and then press letter keys to use menu or
button commands with your keyboard. The letters are underlined in
the menus and in button labels.
Examples:
Alt+S,R opens the Session Recorder with the Sessions menu.

Alt+R opens the Session Recorder with the button
.
You can move the insertion point into a field. For example, Alt+F
moves the insertion point to the Full Name field (People tab).
Alt+Spacebar display the title bar shortcut menu.
Alt+F4 closes SayMore.
Related Topics
User Interface overview

User Interface (UI) overview
This Help book contains the following Help sub-books:
Menus
Shortcut keys
Tabs
Related Topics
Basic Tasks overview
Resizing window panes
SayMore overview
Using Localize User Interface dialog box
Using Tools overview

Project tab tasks
On the

Project tab, the left pane lists three areas you can use.

About this Project
Enter project metadata
Change language

Access Protocol
Choose access protocol for this project.

Descriptive Documents
Add Files
Enter file metadata

Other Documents
Add Files
Enter file metadata

Progress
Review progress data
Progress data is calculated by SayMore. Tasks that affect progress
data calculations include:
Add a session / Add a session from a device / Delete a session
Add a person / Delete a person
Add Files / Delete a file
Rename a file or Select session stages
Session status and genre selections.
Some progress data is based on file metadata, such as recording
durations and file sizes.

Copy, Save and Print commands appear at the top of the right pane.
Related Topics
Basic Tasks overview
How SayMore uses file names
Project menu overview
Project
Tabs overview
Using Tools overview

Change Language
1. Click the

Project tab, and then click About This Project.

The right pane displays project metadata fields (more).
2. Click the Content Language link that is associated with the Content
Language or Working Language.
The Lookup Language Code dialog box appears.
3. In the search box, type the name of the content or working language.
If you see the language click it.
If you do not see the language, type another name for the
language if you know one. Otherwise, click the Can't find your
language? link to search Ethnologue.com or to learn more about
language codes.
If the language is not listed, type a question mark (?) in the
search box to display Unlisted Language code qaa.
4. If necessary, edit the language name in the box that is in the lowerright corner of the dialog box, considering ISO-639 standards.
You need to do this to make the OK button available if you use an
unlisted language.
5. Click OK.
The code and name appear above the associated link. For example
seh: Sena.
Note
The Working Language is usually a Language of Wider
Communication. It is used, for example, for Free Translations in
annotations and in Written Translations.
Related Topics
Change User Interface Language

Project tab tasks

Choose Access Protocol
The access protocol option you choose determines the available choices
in the Access list that you use to select session access.
1. Click the

Project tab, and then click Access Protocol.

2. In the right pane, click the down arrow and then click None, AILCA,
AILLA, ANLA, ELAR, REAP, TLA or Custom.
None provides no choices in the Access list and probably should
only be used temporarily.
Custom - type custom access choices that others would
understand, separated by commas.
Your custom choices literally appear, just as you typed them, in the
Access list and in the archive as metadata.
Related Topics
Access Protocol
Archiving overview
Localizing Access Protocol Information
Project tab tasks
User Interface terms - Project tab

Copy Save or Print Progress data
Review the progress data, then do any of the following:
Copy
1. Click Copy to copy the Progress data to the clipboard.
2. Paste (Ctrl+V) the data from the clipboard into another program,
such as LibreOffice.
Save
1. Click Save to save the Progress data into an HTML file.
2. Choose the folder.
3. In the File name box, type a name for the file.
4. In the Save as type box, leave the file type as HTML File (*.html).
If you change it to see other file types, or manually edit the file name
extension, you may not be able to open the file.
5. Click Save.
Print
1. Click Print to send the Progress data to your printer.
2. In the Print dialog box select print options, and then click Print.
Related Topics
Project tab tasks

Enter project metadata
Do any of the following in the

Project tab:

1. Click About This Project.
In each field, type or choose metadata.
Be aware that SayMore copies the location metadata to
corresponding fields when you add a session. If you change this
location metadata SayMore does not update the corresponding
fields in existing sessions.
2. Click Description Documents.
Add files that describe the project and the corpus.
Enter file metadata.
3. Click Other Documents.
Add files that are not specifically "descriptive documents" nor
apply to a specific session or person.
Enter file metadata.
Note
The View tab preview ability is limited to files that open in Internet
Explorer, plus pdf files. See: Open in Program Associated with this
File and Show in File Explorer.
When you archive with IMDI:
Files in Descriptive Documents are exported to a special session
named Project Descriptive Documents.
Files in Other Documents are exported to a special session
named Other Project Documents.
Related Topics
Archive the Project
Archive a session

Project tab description
Project tab tasks
User Interface terms - Project tab

Review progress data
Project tab tasks lists tasks that affect the progress data.
1. Click the

Project tab, and then click Progress.

2. Click the refresh button ( ) and then review the progress data:
Overview shows the number of sessions and people in the
project, and the total durations (times) and sizes of the Source
Recordings, Careful Speech, and Oral Translation files.
By Stages shows progress by stages of completion:
Each stage displays the number of sessions with content or files at
that stage, and the total number of minutes (sum of durations) of the
audio files in those sessions.
No colored bar means that there are no sessions at that stage.
By Genre shows progress by genres:
Each displayed genre shows the number of sessions with that genre
selected and that have at least one named file, and the total number
of minutes (sum of durations) of the audio files in those sessions.
Here a bar can have more than one color. The colors match the
selected session status (Incoming, In Progress or Finished); the
numbers in them are the total number of minutes (sum of durations)
of the audio files in those sessions. The relative lengths of colored
segments reflect the number of minutes of audio. Example:

3. Optionally, use Copy, Save or Print.
Related Topics
Project tab description
Project tab User Interface terms overview

Sessions tab tasks
In the
Sessions tab, the Sessions (left) pane lists sessions that are
stored in the open SayMore project.
Here are tasks you can do in this tab:
Add/Delete a session:
Add an empty session
Add a session from a device
Add a session from a new recording
Delete a session.
Add/Delete/Play files
Add files to a session
Enter file metadata
Delete a file
Play a media file.
Archive a session (RAMP / IMDI)
Session tab:
Enter session metadata
Access, select session
Contributors tab, use the
Roles list sample.
Start Annotating tab:
Convert Media
Create Annotation File
Copy an existing ELAN file
Read an Audacity Label file

Use auto segmenter
Use Careful Speech Tool
Use Manual Segmentation Tool.
Annotations tab:
Annotations tab overview / Media Annotation overview
Annotations, working with
Record Careful Speech annotations
Record Oral Translation annotations
Manually segment an audio file
Export annotations.
Status & Stages tab:
Status & Stages tab overview
Select session stages
Select session status.
Related Topics
Basic Tasks overview
Choose columns
Sessions tab description
User Interface terms - Sessions tab
Using Tools overview

Add an empty session
To add a new empty session to the current project, do the following steps:
1. Click the

Sessions tab.

2. Do one of the following:
On the Session menu, click New.
Click the New button which is near the bottom of the Sessions
(left) pane.
A new session is added.
3. Enter session metadata.
4. As necessary, add files to the new session.
Enter or edit file metadata.
Related Topics
Add a session from a device
Add a session from a new recording
Tabs overview

Add a session from a device
When you copy media (audio or video) files into SayMore from a
recording device, SD card, flash drive, or other device, each file becomes
a new session in the open project.
1. Make the device available to your computer (connect it with wires,
insert the SD card or flash drive, and so on).
2. Click the

Sessions tab.

3. Do one of the following:
On the Session menu, click New From Device.
Click the New From Device button which is near the bottom of
the Sessions (left) pane.
The New Sessions from Device dialog box appears.
If SayMore cannot access the folder where files were located the last
time you used this feature, a warning ( ) message appears. In this
case, or to find files that are stored in a different location, do the
following:
Click the Find Files on Recorder/Card link.
The Browse for Folder dialog box opens, so you can browse for
the folder that has the files you want.
Click the desired folder, and then click OK.
If you see an error message, see Note below.
4. In the Incoming Files pane (New Sessions from Device dialog
box), select ( ) the file or files that represents the source recording
of a session.
To select ( ) or clear ( ) all the files at the same time, select or
clear the check box that is in the column header.
5. If necessary, do any of the following:
Play the media file (with the player that is in the dialog box) to

verify that this is the desired file.
Click a row to highlight the file. Then, click Open, and then click
Show in File Explorer, or Open in Program associated with
this File.
The Create <number of> Sessions button displays the number of
selected ( ) files.
6. When all the files you want are selected, click Create <number of>
Sessions.
The Creating Sessions progress box appears.
7. When the process is finished, click OK.
Each selected file is added to the open project as a new session.
When there are selected files with the same file name, but different
file name extensions, those files are all added to the same new
session. Typically, some metadata which is specific to the audio or
video file is automatically added to SayMore when you create a new
session from a device (or extract the audio from a video file).
8. Do any of the following:
Enter or edit session metadata.
Add files to the new sessions.
Enter or edit file metadata.
Note
Media player file name has not been specified error message
appears if a default Media Player has not been specified for the file
extension type you are trying to bring into SayMore.
Click OK and continue with your work in SayMore.
You will get this message each time SayMore attempts to
display/play the media file until you do the following: right-click on
the media file and then click Show in File Explorer. In Windows
File Explorer, right-click on the media file, hover over Open with,
then left-click Choose default program. Select one of the options.

Select the check box: Always use the selected program to open
this kind of file. Click OK.
You will want to do this for each different media file extension
(.mpg, .avi, and so on).
The source device is displayed to the right of the File Files on
Recorder/Card link.
See Also: How SayMore uses file names.
Related Topics
Add an empty session
Add a session from a new recording
FFmpeg (utility)
Tabs overview

Add a session from a new recording
You can record a speaker using SayMore features and allow SayMore to
add a session to the current project as part of the recording process.
A microphone is required for this task.
1. Click the

Sessions tab.

2. Do one of the following:
On the Session menu, click New From Recording.
Click the New from Recording button which is near the bottom
of the Sessions (left) pane.
The Session Recorder dialog box appears.
3. Do the following:
Click

Record, and speak into the microphone.

When you are done, click

Stop.

To listen to the recording, click

Playback Recording.

If you are satisfied with the recording, click OK. Otherwise, click
Cancel. Then, open this dialog box again, and make a new
recording.
A new session is added, and the recording is automatically added to
it.
4. Enter session metadata.
5. As necessary, add files to the new session.
Enter or edit file metadata.
Note
If you click Stop and then click
Record again, the new recording
is added to the previous one. That is, it does not record over the
previous one.

The Session Recorder has a level indicator. It shows green, yellow
and red recording levels, and a line that shows recent peaks. Make
sure to not have too many peaks in yellow or red areas.
Properties of the recording appear at the bottom and are added as
metadata. You can see them in the Properties tab with that
<name>.wav file is selected.
Related Topics
Add an empty session
Add a session from a device
Tabs overview

Create Annotation file
The Start Annotating tab lists optional ways you can use to create, copy
or read an annotation file for an audio file. Media Annotation overview
describes needed files.
1. Click the

Sessions tab.

2. In the Sessions (left) pane, click the session that has the audio file.
Add a file or extract an audio file from a video file, if necessary.
3. In the right pane, click the audio file.
4. Rename the audio file to Source, if the file name does not include
Source.
5. Click the Start Annotating tab.
Be aware that this tab only appears if you have not already started the
annotation process.
6. If File Conversion Required appears, click Convert to convert a
copy of your file to a different file format.
7. Select a segmentation method, and then click Get Started.
8. Do one of the following:
To insert segment boundaries using SayMore features, see Use
Manual Segmentation Tool, Use Careful Speech Tool or Use auto
segmenter.
If you have ELAN or Audacity files with segments already
identified, choose Copy an existing ELAN file or Read an
Audacity Label file. Click the file, and then click Open.
A <name>.<type>.annotations.eaf file is added, and appears
subordinate to the parent audio file (example).
Note
When a <name>.wav file is selected the Audio tab is initially
displayed.

After an annotation file ( <name>.<type>.annotations.eaf) is
displayed in the session, the Start Annotating tab is not available.
If you click that annotations ( ) file, the Annotations tab is
displayed. You can record Careful Speech annotations and Oral
Annotations, and work with Transcriptions and Free Translations
for the segments.
Avoid segments with more than one sentence if you will export the
data to FLEx.
Related Topics
Audacity
ELAN
Generated Audio tab overview
Sessions tab description
Sessions tab tasks

Convert Media
When you create an annotation file, some audio files need to be
converted to a different file format, or SayMore needs to extract an audio
file from a video file. You can use the Convert command on the toolbar
or in the Start Annotating tab.
Do the following:
1. Click the

Sessions or

People tab.

2. In the left pane, click the session or person.
3. In the right pane, click the audio or video file.
4. Do either of the following:
At the top of the right pane, click the Convert button.
Right-click the file and click Convert.
The Convert Media dialog box appears. If necessary, click Download
to download and install FFmpeg.
5. In the Available Conversions box, select the desired conversion.
Examples (not exhaustive):
Convert to H.263/MPEG-4 video with AAC Audio
Convert to H.264/MPEG-4 video with AAC Audio
Convert to MPEG-1 video with MP2 Audio
Convert to MPEG-2 video with MP3 Audio
Convert to Xvid/MPEG-4 AVC video with AAC Audio
Extract audio to mono mp3 audio file (low quality)
Extract audio to standard WAV PCM audio file
6. Click Begin Conversion.
Conversion Finished Successfully appears in the dialog box. A
Show Details button also appears.

7. Optionally, click the Show Details button to see details and various
metadata.
8. Click Close.
The converted or extracted copy of the file appears in the list of files,
with an appropriate file name change.
Related Topics
Basic Tasks overview
File formats in SayMore
People tab tasks
Sessions tab tasks
Related Internet Sites
http://en.wikipedia.org/wiki/H.263
http://en.wikipedia.org/wiki/H.264/MPEG-4_AVC
http://en.wikipedia.org/wiki/MPEG-1
http://en.wikipedia.org/wiki/MPEG-2
http://www.xvid.org/
http://en.wikipedia.org/wiki/Audio_file_format

Delete a session
1. Click the

Sessions tab.

2. In the Sessions (left) pane, click the session you want to delete.
3. Do one of the following:
Right-click that session, and then click Delete.
On the Session menu, click Delete this Session.
The Confirm Delete message box appears.
4. Click

Delete.

Related Topics
Sessions tab description
Sessions tab tasks

Enter session metadata
1. Click the

Sessions tab.

2. In the Sessions (left) pane, click the desired session.
3. In the top-right pane, click the
4. Click the

<name>.session file.

Session tab.

5. Type or select content for the fields in this tab (more).
SayMore copies existing location project metadata to corresponding
fields below More Fields. If you change the location metadata in the
Project tab it is not updated in existing sessions.
If needed, enter content in Custom Fields.
6. Optionally, click the Notes tab, and then type notes about the
session in prose.
SayMore provides no formatting features, and data you paste here
loses any formatting. You can make numbered/bulleted lists with your
keyboard.
Note
User Interface terms - Session tab describes terms as you work with
metadata for each session. Metadata you enter here may be included
as archived metadata.
means the tab has existing content.
means the tab is empty.
Asterisks indicate that SayMore added a Warning to the
Notes tab, such as for an ambiguous date format in the metadata. In
this case, follow the instructions given in the Warning message.
Related Topics
Custom Fields
Enter file metadata

Enter Person metadata
Enter Project metadata
More Fields
Project tab description
Sessions tab description
Sessions tab tasks
Work with Custom Fields

Generated Audio tab overview
This tab appears in the bottom part of the right pane of the Sessions tab
when you click an oralAnnotations file ( <name>.
<type>.oralAnnotations.wav).
This tab shows three lines with waveforms, if recorded:
Source - shows waveforms from the source file
Careful - shows waveforms for careful speech annotation
Translation - shows waveforms for oral translation annotations
To refresh the waveforms, click

Regenerate.

Click Play to hear the source, careful speech, and oral translation
recordings, in that order, one-segment-at-a-time. Notice that the
segments are staggered to facilitate this.
Tip
In the Annotations tab, click Oral Annotations Tools, and then
click Careful Speech or Oral Translation. Then you can record these
annotations.
Related Topics
Annotations tab overview
Create Annotation file
Media Annotation File overview
Sessions tab description
Sessions tab tasks
Source Recording
Stages of completion

Media Annotation overview
Here is an overview of how to begin annotating a media file using
SayMore. For detailed help with Audacity or ELAN, refer to their
respective Help systems.
When you annotate a media stream, you don't do it all at once. You listen
to a bit, annotate it, and move on to the next segment. You can add
segment boundaries in SayMore with the Careful Speech Tool or Manual
Segmentation Tool, or you can do this segmenting outside of SayMore
with Audacity or ELAN.

Files
SayMore requires two different files:
a media file (e.g. a *.wav audio or an *.mp4 video from which you can
extract a .wav audio file), and
an ELAN file that contains the time segment data and textual
annotations for that media file (*.annotations.eaf).
Of course you must provide the media file. But for the ELAN file, you
can either let SayMore create it for you, or you can provide an existing
one (but you have to first make it conform to SayMore's expectations
for ELAN files.

Forms of Annotations
If you use Read an Audacity Label file or the Copy an existing
ELAN file option on the Start Annotating tab, you can see those
transcriptions and free translations in the Annotations tab.
Then you can record oral translation annotation and careful speech
annotations, or edit the transcription and free translation annotations.
Related Topics
Export Annotations for FieldWorks Interlinear
Generated Audio tab overview

Sessions tab description
Sessions tab tasks

Select session access
Selecting session access is part of entering session metadata. But you
can change it at any time for a session.
1. Click the

Sessions tab.

2. In the Sessions (left) pane, click the desired session.
3. In the top-right pane, click the
4. Click the

<name>.session file.

Session tab.

5. Click the Access field down-arrow, and then click an access choice.
If necessary, do any of the following in the

Project tab:

Choose a different Access Protocol option.
Add additional options in the Custom Access Choices field.
Related Topics
Access Protocol
Sessions tab description
Sessions tab tasks

Selected Segment Boundary example
In the Manual Segmenter dialog box, you can click a segment boundary
to select it. When a segment boundary is selected, you can move it or
delete it.
Example
Here, the middle segment boundary is selected.

Related Topics
Sessions tab description
Sessions tab tasks

Use auto segmenter
Use auto segmenter is one of the segmentation methods available on
the Start Annotating tab.
It programmatically inserts segment boundaries to form intonation
groups. Currently, the SayMore user interface has no features you can
use to affect where segment boundaries are initially inserted. But, you
can add, remove or move boundaries later.
1. Click the

Sessions tab.

2. In the Sessions (left) pane, click the session.
3. At the top of the right pane, click the file you will annotate.
Create an annotation file, if there is not one already.
4. In the Start Annotating tab, click Use auto segmenter.
5. Click Get Started.
The resulting

*.eaf file is added to the top of the right pane.

The Annotations tab appears and displays one row for each segment
at the bottom of the pane.
Add, remove or move segment boundaries as needed.
Note
Working with annotations discusses how to add transcriptions and
translations to each segment.
Related Topics
Annotations tab overview
Sessions tab tasks

Use Careful Speech Tool
On the Start Annotating tab, a segmentation method you can select is
Use Careful Speech Tool. It opens the file in the Careful Speech
Recorder dialog box.
You will need a microphone for this task. You can click and drag an edge
of the Careful Speech Recorder dialog box to resize it.
1. Press and hold the SPACEBAR key, or click and hold
Listen to
begin listening to the recording. As you listen to the audio, do the
following:
Watch the vertical line move through the waveform. Release the
SPACEBAR key or mouse button when the line is at the location
where you want a segment boundary.
Press and hold the SPACEBAR key again, or click and hold the
Speak button, while you speak the careful speech annotation
of that portion. Then, release the key or button.
Alternatively, click
to use.

to ignore a segment that you do not want

If necessary, click
or
to remove the most recently
added careful speech annotation or to clear Ignore.
Repeat this step above until all segment boundaries are set and
careful speech annotations are recorded.
2. To hear a careful speech annotation, hover your mouse pointer over
that segment, and then click
in that segment.
If the annotation is not acceptable, click and hold
while you
speak the careful speech annotation for the segment again.
This records the new annotation over the old one.
If the annotation is acceptable, repeat this step for the next
segment.

If necessary, for a segment that is not usable as an example of
speech, click Ignore.
3. Click OK.
Related Topics
Careful Speech
Delete annotations
File formats in SayMore
Sessions tab description
Sessions tab tasks
View a text or image file

Use Contributors tab
A Contributors tab appears when you click a file that was added to the
Sessions tab. This tab shows rows and columns you use to collect
metadata regarding who contributed to that file and any subordinate files.
Do any of the following:
Add or edit contributor metadata:
1. In the Name column, type the name of a contributor.
If the contributor is also currently in the People list, a drop-down list
appears as you type. You can select the person in that list.
2. In the Role column, select the contributor's role from the list.
3. In the Date column, select the date of the contribution.
4. In the Comments column, type additional information about the
contributor or the contribution made.
This is optional. The comments need to be brief. No scroll bars will
appear, and the lines do not wrap. You can change column widths.
5. Repeat this step for each person who contributed to the added
file.
Remove a contributor (remove a row):
Click the row, and then click the
end of that row.

button that appears at the right

Examine the contributions made by a person in the Contributions tab
(more).
Related Topics
Basic Tasks overview
Enter file metadata
Role list sample
User Interface terms - Contributors tab

Use Manual Segmentation Tool
On the Start Annotating tab, a segmentation method you can select is
Use Manual Segmentation Tool. It opens the file in the Manual
Segmenter dialog box. You can zoom in and out with the Zoom control
or with shortcut keys.
1. Click
file.

Listen, or press the SPACEBAR key, to start listening to the

Watch the green line move through the waveform, or watch the
duration values (lower right corner) to determine where to add
segment boundaries:
At the location where you want a segment boundary, or after a
desired duration has played, click Add Segment Boundary or
press the ENTER key.
The file playback continues, so you can click Add Segment
Boundary, or press the ENTER key, at each location where you
want a segment break.
2. To choose a particular location in the file to begin the playback, click
the desired area in the waveform. This moves the green line. Then,
click Listen, or press the SPACEBAR key.
3. To stop the playback, click

Stop or press the SPACEBAR key.

4. To listen to a particular segment, move your mouse over that
segment and then click the

button (play segment) that appears.

5. Listen carefully to the playback again and carefully observe the
positions of the segment boundaries.
Move a boundary: click (example) and drag it.
Ignore a segment you do not want to use: click
Clear an Ignore: click

.

.

Remove a boundary: click it, and then click
boundary or press the DELETE key.

Delete Selected

6. Click OK.
Important
The wave file appears in the upper portion of the dialog box. Below it
on the right is a Segments count. To the right of that count are file
duration values: the duration of the file that is to the left of the green
line (has been played, typically) / the total duration of the file.
If segment is too short, the Add Segment Boundary button label
changes to inform you.
After you have set segment boundaries and closed this dialog box
again, the Start Annotating tab no longer appears.
From an Annotations tab, click
Segmenter dialog box.
Related Topics
File formats in SayMore
Sessions tab description
Sessions tab tasks
View a text or image file

Segment to open the Manual

Annotations tab overview
When you click an annotation file, ( <name>.<type>.annotations.eaf),
the tab at the bottom portion of the right pane is named Annotations.
It displays a grid of rows and columns, and various controls.
Rows: Each row is a segment. Each one can display a play/pause
button ( / ). If you hover your mouse pointer over the button you see
pop-up tool-tip with information about that segment.
Columns: There is a Transcription column and Free Translation
column. You type the transcription and translation for the segment in
them. Each column has an Options down arrow ( ) so you can
choose which recording you want to hear, or to change the font for the
column.
Controls allow you to do the following:
Work with annotations - listen to individual audio segments in
SayMore, and then type or edit a transcription or translation (of the
transcription) for each segment.
Record Careful Speech annotations
Record Oral Translation annotations
Add, Remove or Move Segment Boundaries
Delete annotations
Export the annotations in various file formats.
Note
Playback Speed allows you to reduce the rate that the audio
file is played. You can select a percentage of the normal speed, which
is 100%.
You can open the file again in ELAN, and work with the annotations
there.
To listen to the entire audio file, you can click the file, and then play it
in the Audio tab.

Related Topics
Generated Audio tab overview
Media Annotation File overview
Sessions tab description
Sessions tab tasks
Shortcut Keys overview
Stages of completion

Add, Remove, or Move Segment Boundaries
After you have an annotations file ( <name>.<type>.annotations.eaf)
with segment boundaries ( ), you can use the Manual Segmenter dialog
box again to add, remove, or move them. This is likely after you use the
auto segmenter.
To open this dialog box:
1. Click the annotations file that you want to change.
2. Click

Segment in the Annotations tab.

3. Use the Manual Segmenter dialog box.
Related Topics
Annotations tab overview
Selected Segment Boundary example
Use the Manual Segmentation Tool

Delete annotations
Delete an annotation for one segment:
The Oral Translation Recorder and Careful Speech Recorder tools
each have a button that you can use to erase and record a new
annotation for a segment.
That button looks like this:

.

See: Record Oral Translation annotations or Use Careful Speech Tool.
Delete all existing annotations:
To remove only the recorded annotation files you would need to work
in the file system.
If you need to do this, get more help (recommended).
Alternatively, you could delete the

<name>.annotations.eaf file.

However, be aware that deleting the .eaf file will also delete all
subordinate files:
<name>.oralAnnotations.wav file
any segmentation information
any written transcriptions and translations.
If the session is almost complete, this alternative is not recommended.
Related Topics
Annotations tab overview
Delete a file

Export Annotations overview
After you create an annotation file that has segment boundaries, and
work with annotations, you can export the transcription and free
translations to a file of various formats.
1. Click the

Sessions tab.

2. In the Sessions (left) pane, click the session that has the media (
or ) file.
3. In the right pane, click the annotation file ( <name>.
<type>.annotation.eaf), and then click the Annotations tab.
4. Click Export (near
options below.

Segment), and then click one of the export

The Save As dialog box opens. Choose where to save the file,
and review the file name. Leave the Save as type set to the
default selection. Click Save.
Export option

Result

Audacity Label
File (Free
Translation)

SayMore stores the free translation
information in a Text File (*.txt) file.

Audacity Label
File
(Transcription)

SayMore stores the transcription information
in a Text File (*.txt) file.

ELAN File

SayMore already has stored the information
in an ELAN format (*.eaf). So, just double
click the <name>.annotations.eaf file to open
it in ELAN.

FLEx Interlinear
Text

See: Export Annotations for FieldWorks
Interlinear.

Plain Text

SayMore stores the transcription information
in a Text File (*.txt) file.

Subtitles File
(Free
Translation)

SayMore stores the free translation subtitle
information in a SRT Subtitle (*.srt) file.

Subtitles File
(Transcription)

SayMore stores the transcription information
in a SRT Subtitle (*.srt) file.

Spreadsheet
(CSV) File

SayMore stores the information in a Comma
Separated Values (*.csv) file.

Toolbox File

SayMore stores the information in a Toolbox
Standard Format File (*.txt) file.

Related Topics
Annotations tab overview
Related Internet Sites
http://www.fileinfo.com/extension/srt

Export Annotations for FieldWorks Interlinear
After you create an annotation file with segment boundaries and work
with annotations, you can export the transcriptions and free translations
to a file. You can import that file into the FieldWorks Language Explorer
(FLEx).
1. Click the

Sessions tab.

2. In the Sessions (left) pane, click the session.
3. In the right pane, click the annotation file (
<type>.annotation.eaf).

<name>.

In the Annotations tab, review your transcriptions and free
translations.
4. Click Export (it is near the
FLEx Interlinear Text.

Segment button), and then click

The Export Annotations for FieldWorks Interlinear dialog box
appears.
Select the writing system of the transcriptions.
It must match the vernacular writing system used in the FLEx
Baseline tab.
Select the writing system of the free translations.
It must match the analysis writing system used in the FLEx Free line.
Click Export. Click the desired folder. Click Save.
Important
If a segment contains more than one sentence, the Free Translation
content may not appear in the correct Free lines in FLEx.
In this case, you can change segment boundaries or just manually
move the Free line contents in FLEx.
If you changed segment boundaries:
1. In FLEx, delete the text.

2. Export the SayMore annotations file again.
3. Import the new file into FLEx.
Some files may require multiple iterations of these steps.
A SayMore-FLEx-ELAN workflow is discussed here:
https://www.academia.edu/6474779/Producing_timealigned_interlinear_texts_Towards_a_SayMore-FLEx-ELAN_workflow
Related Topics
Annotations tab overview
Related Internet Sites
http://software.sil.org/fieldworks/

Record Careful Speech annotations
If you did not already add careful speech annotations when you created
an annotation file, you can record a careful speech annotation for each
segment.
1. Click the

Sessions tab.

2. In the Sessions (left) pane, click the session that has the media (
or ) file.
3. In the right pane, click the annotation file ( <name>.
<type>.annotations.eaf), and then click the Annotations tab.
The individual segments appear in rows. Any transcriptions or
translations you added in ELAN or in Audacity appear in columns.
4. Click

Oral Annotations Tools, and then click Careful Speech.

5. Use the Careful Speech Tool.
Related Topics
Annotations tab overview
Generated Audio tab overview
Media Annotation File overview
Sessions tab description
Sessions tab tasks
Work with annotations

Record Oral Translation annotations
After you create an annotation file, you can record an oral translation
annotation for each segment. You need a microphone and speakers
connected to the computer. Try to keep the microphone at the same
distance from your mouth for all segments to help make sure the volume
level is consistent.
1. Click the

Sessions tab.

2. In the Sessions (left) pane, click the session that has the media (
or ) file.
3. In the right pane, click the annotation file (
<type>.annotations.eaf).

<name>.

The individual segments appear in rows in the Annotations tab. Any
transcriptions or translations you added in ELAN or in Audacity
appear in columns.
4. Click

Oral Annotations Tools, and then click Oral Translation.

The Oral Translation Recorder dialog box opens. There is the
Source Audio track and the Oral Annotation track.
Click the segment you want to hear, and then do one of the
following:
Press and hold the SPACEBAR key, click Listen to this segment (
), or click and hold

.

When the segment as fully played, the focus moves to the Speak
button and the Oral Translation track.
To record an Oral Translation annotation for that segment, click
Speak
, or press and hold the SPACEBAR key, while you
carefully speak it into the microphone.
The focus moves to the Listen to this segment (

) button in the

next segment, so you can repeat the steps above for that
segment.
For any segment, click and hold the
button and speak again to
record an new oral translation annotation for that segment.
5. When all the segments have a quality oral translation annotation,
click OK.
6. In the right pane, click the <name>.<type>.oralAnnotations.wav file.
The Generated Audio tab appears.
Click Play to hear the Source and Careful recordings (if
recorded), and the Translation recording, one segment at a time.
7. Click the original source file, and then enter metadata about the oral
annotations file in the Contributors tab, and if necessary in the Note
tab.
Tip
You can select ( ) Ignored to ignore a segment or Undo to stop
ignoring it.
Press the b key on your keyboard to listen again to a source audio
segment that does not yet have an oral translation.
Related Topics
Annotations tab overview
Delete annotations
Generated Audio tab overview
Media Annotation File overview
Sessions tab description
Sessions tab tasks
Work with annotations

Working with fonts for Transcriptions or Free
Translations
In the
Sessions tab, when you have an annotations file with segment
boundaries ( <name>.<type>.annotations.eaf), the Annotations tab
shows a Transcription column and a Free Transcription column.
Do the following, as necessary:
1. Click Options in the heading of a column (Transcription Options
or Free Translation Options ), and then click Fonts.
The Font dialog box opens.
2. In the dialog box, select
a different font, font style, or font size
an effect or script, if necessary.
3. Click OK.
4. If necessary, repeat the steps above for the other column.
Related Topics
Annotations tab overview

Working with annotations
After you create an annotation file, you use the Annotations tab. On this
tab you listen to segments, one at a time, and type transcriptions and
translations for them. Annotations tab overview for more tasks you can
do from this tab.
1. Click the

Sessions tab.

2. In the Sessions (left) pane, click the session that has the media (
or ) file.
3. In the right pane, click the annotation file ( <name>.
<type>.annotations.eaf), and then click the Annotations tab.
The individual segments appear in rows. Any existing transcriptions
or translations appear in columns. If you ignored a segment, the
Transcription column contains "Ignored".
4. Click the row for the segment you want to hear.
Do any of the following:
Click Options in the Transcription column header, and select
which available recordings you what to hear: Source, Careful
Speech, or both.
Click Options in the Free Translation column header, and
select which available recordings you what to hear: Source, Oral
Translation, or both.
To play the segment, click

.

This plays the segment five times. Press the F2 on your
keyboard or click again, if you need to hear the current
segment again.
To pause the playback, click

.

To change the playback speed, click
(playback speed
control), and select a percentage of the normal speed.
Click the cell in the Transcription column. If necessary, manually

turn on a different keyboard. Type or edit the transcription.
Click a cell in the Free Translation column. Type or edit the
translation of the transcription.
Press Tab, or click the next row to continue.
5. Enter metadata about the annotation file in the Contributors tab,
and in the Note tab (optional).
Tip
The text you type in the columns will wrap when it is wider than the
column. The row height will adjust when you click another row. Then
you can see all that you typed.
You can change fonts, font styles and font sizes for the Transcription
and Free Translation columns individually.
In the Annotations tab, use this control to choose the rate (speed) of
the audio file playback:

(Drop-down list displayed; Normal speed is 100%.)
You can listen to the source audio file in the Audio tab.
You can open the file in ELAN, and work with the annotations there.
Related Topics
Annotations tab overview
Audacity
Delete annotations

ELAN
Generated Audio tab overview
Media Annotation File overview
Sessions tab description
Sessions tab tasks
Shortcut Keys overview
Stages of completion

Status & Stages tab overview
In the
Sessions tab, you can use the Status & Stages tab to select
the status and the current stage of completion for the session currently
selected in the Sessions (left) pane.
Select session status
Select session stages
Related Topics
Sessions tab tasks

Select session stages
In the
Sessions tab, use the Status & Stages tab to control the
stages of completion. Each check box below Stages has three states:
completed, not completed, and automatic (the default state).
In the automatic state, SayMore selects the appropriate stage to indicate
that the stage is completed based on renamed files or annotation work. If
you manually select or clear a check box, you turn off the automatic
feature for that stage.
1. Click a check box for any of these reasons:
Manually select a stage that has been completed.
Click it until you see a check mark ( ).
Manually clear a check box for a stage that is not completed.
Click it until the check box is empty ( ).
Let SayMore automatically keep track of the particular stage for
you.
Click it until you see a gray check mark ( ).
The Stages column is updated.
The label for the stage may darken or lighten to indicate whether it is
set to automatic or manual control.
2. Optionally, review the progress data.
Related Topics
Status & Stages tab overview

Select session status
In the
Sessions tab, use the Status & Stages tab to select the status
of the current session. This is a high-level status.
1. Click the status level of the current session:
Incoming ( )
Select this status when you are collecting the recording and its
metadata, even if you may not do any additional work with it.
In Progress ( )
Select this status when you are working on this session.
See Also: Select session stages.
Finished ( )
Select this status when you are done with this session.
Skipped ( )
Select this status if you have decided to not develop this session at
this time.
2. Optionally, review the progress data.
Related Topics
Status & Stages tab overview

People tab tasks
Here are things you can do in the

People tab:

Add a person
Add/change a person's picture
Enter person metadata
Delete a person
Add files to a session
Use Contributions tab
Role list sample
Related Topics
Basic Tasks overview
People tab description
User Interface terms - People tab
Using Tools overview

Add a person
1. Click the

People tab.

2. Do one of the following:
On the Person menu, click New.
Click the New button which is near the bottom of the People (left)
pane.
A new person is added and is available for selection in the
tab.

Session

3. Enter person metadata.
Note
You cannot have more than one person with the same full name. In
this case, a warning ( ) box will appear. You may need to include a
middle initial or some other distinguishing addition.
Related Topics
People tab tasks

Add/change person's picture
1. Click the

People tab.

2. In the People (left) pane, click the person.
3. In the right pane, click the person file, and then click the Person
tab, if it is not already selected.
4. Do one of the following:
Drag-and-drop a picture of the person on the picture placeholder.
Click the picture placeholder or current picture to open the
Change Picture dialog box. Click the desired picture, and then
click Open.
The picture replaces the placeholder or the existing picture. It also
appears as an image file at the top of the right pane.
Picture placeholder

Related Topics
Delete a file
Enter person metadata
People tab tasks

Delete a person
1. Click the

People tab.

2. In the People (left) pane, click the person you want to delete, and
then do one of the following:
On the Person menu, click Delete Person.
Right-click the person, and then click Delete Person.
The Confirm Delete warning box appears.
3. Click

Delete.

Related Topics
People tab tasks

Enter person metadata
1. Click the
pane.

People tab, and then click the person in the People (left)

Add a person if necessary.
2. In the right pane, click the person file ( ), if it is not already selected.
3. Click the

Person tab.

4. Type or select content for each of the fields in this tab (more).
If needed, enter content in Custom Fields.
5. Add a picture of the person.
6. Optionally, click the Notes tab, and then type notes about the person
in prose.
There are no formatting features for you to use, but you can manually
make a number or bulleted list with your keyboard. You can also paste
data you copied from another source.
Note
User Interface terms - People tab describes terms for person
metadata.
You cannot have more than one person with the same full name. A
warning ( ) box will appear. You may need to include a middle initial
or some other distinguishing addition.
means the tab has existing content.
means the tab is empty.
Asterisks indicate that SayMore added a Warning to the
Notes tab, such as for an ambiguous date format in the metadata. In
this case, follow the instructions given in the Warning message.
Related Topics
Informed Consent

Enter file metadata
Enter Project metadata
Enter Session metadata
People tab description
People tab tasks
Using the Contributors tab
Work with Custom Fields

Use Contributions tab
A Contributions tab shows rows and columns. They display metadata
(not editable here) that was added in a Contributors tab.
1. Click the
pane.

People tab, and then click a person in the People (left)

2. In the right pane, click the

person file.

3. Click the Contributions tab, and examine the contributions
currently attributed to that person:
The Name columns displays sessions in which the person was a
contributor.
The Role column displays the role of the person's contribution to
that session.
The Date is the Date Modified date for the file to which the
contribution was made.
The Comments column shows any comments that were added.
4. Use the Contributors tab in a session to make changes (more).
Related Topics
Basic Tasks overview
Contributor
Enter file metadata
Role list sample
Use Contributors tab

Using Tools overview
Task topics for each tab are listed in these topics:
Project tab tasks
Sessions tab tasks
People tab tasks
Note
Basic Tasks overview lists additional tasks that are done frequently or
can be done more than one tab.
Related Topics
SayMore overview
Shortcut Keys overview
User Interface overview

Glossary of Terms
User Interface Terms overview and associated topics (in Tabs Help
sub-book) gives definitions of UI terms. See also: Concepts overview.
So this Glossary of Terms is not exhaustive.
To find a term in the glossary, click the letter that is the first letter in the
word or phrase you want to look up. Symbols shows icons and buttons
(not exhaustive) you see in the SayMore User Interface (UI).

A B C D E F G H I J K L M N O P Q R S T U V W
X Y Z Symbols

B
BOLD - Basic Oral Language Documentation
(http://www.boldpng.info/bold).

C
Careful speech - "Respeaking" the words in the source recording
carefully at a location that is free from background noise and
interruptions. The Source Recording is spoken in a more naturally, less
controlled, way.
For a session, if a careful speech recording was produced outside of
SayMore, you can add that file to the session and then rename it to
include Careful. Then, the Careful Speech stage is marked as
completed.
To complete this stage in SayMore, use the Careful Speech
Recorder. When a <name>.annotations.eaf file is selected, the
Annotations tab is displayed. It has controls that open this oral
annotation tool.
See Also: Oral Translation.

E
Event - See: Session.

F
Free Translation (column)- When a <name>.annotations.eaf file is
selected, the Annotations tab is displayed. One of the columns is called
Free Translation. When this column has content in all rows, the Written
Translation stage is marked as completed. See Also: Written
Translation.

I
IMDI - (ISLE Meta Data Initiative) is a metadata standard to describe
multi-media and multi-modal language resources. The standard provides
interoperability for browsable and searchable corpus structures and
resource descriptions. See: http://tla.mpi.nl/.
Informed Consent - the permission given by a participant (speaker) to
use his or her intellectual property, such as spoken words. Informed
consent may be in the form of an audio or video file, photographs, signed
forms, a photograph of a signed form, and so on. Providing
documentation of this permission is one of the stages.

L
Language of Wider Communication (LWC) - a language used by
people as a medium of communication across language or cultural
barriers. The LWC may or may not be the vernacular ("mother-tongue")
of any of these people.

M
Metadata - data about data. For information management and other
purposes, these data describe the key data. Metadata assist with
discoverability of that data. They provide classifications, rights (Informed
Consent, and so on), who was involved, what equipment was used,
format, and much more. Of course, the name of a file is metadata.
For example, consider possible metadata for a video file: "Duration
01:25:10"; "Bit Rate 48000 Hz"; "Frame Resolution 176x144" - these
describe the video, but to see the actual data, you need to watch the
video.
In SayMore, you enter metadata in the Properties tab, Contributors
tab, Notes tab, file names and so on. Some is added automatically,
other metadata is added manually.

O
Oral Translation - a spoken translation from the vernacular language to
another language (usually English) given by speakers of the vernacular
language.
For a session, if an oral translation recording was produced outside of
SayMore, you can add that file to the session and then rename it to
include OralTranslation. Then, the Oral Translation stage is marked
as completed.
To complete this stage in SayMore, use the Oral Translation
Recorder. When a <name>.annotations.eaf file is selected, the
Annotations tab is displayed. It has controls that open this oral
annotation tool.
Original Recording - See: Source Recording.

P
Participants - now referred to as people, in the SayMore user interface
(not to be confused with contributors).
Presets - in Properties tabs, Presets lists any devices or
microphones that have been previously used with this project. You can
select one again and do not need to reenter properties metadata for it.

S
Session - all the files and metadata associated for one language
recording session. A session includes files which are comments on and
annotations of the source recording.
Source Recording - The audio recording of one or more speakers as
some genre of spoken words. This may be the original recording or a
copy of it that has been "cleaned-up" in an audio program. Having this file
is one of the stages. See Also: http://www.boldpng.info/bold.
Stage - in general, a stage is a single step in a process. In SayMore, a
stage (or stage of completion) is a task that must be completed towards
the completion of each session in a language documentation project.
Each session has a Stages column and tab that indicates Incomplete or
Complete for these stages:
Source Recording
Informed Consent
Careful Speech
Oral Translation
Transcription
Written Translation.
These indicate a more detailed view of progress than the Status options.
Status - For each session, you can choose these status indicators:
Incoming, In Progress, Finished or Skipped. Typically, you would not
choose Finished until all the stages of completion are complete for that
session.

T
Transcription - a carefully written record of spoken words in the
vernacular language. (This is different than a written translation.)
For a session, if a transcription was produced outside of SayMore,
you can add that file to the session and then rename it to include
Transcription. Then, the Transcription stage is marked as completed.
To complete this stage in SayMore, enter transcription in the
Transcription column. This column is displayed in the Annotations
tab when you select the <name>.annotations.eaf file.

V
Vernacular Language - in SayMore and these Helps, the term used is
Working Language. It is the language used for transcriptions, unless IPA
in contrast to free translations.

W
Windows Explorer - a feature in Microsoft Windows operating systems
that shows the hierarchial structure of the files and fonder on a computer.
It is different, and not to be confused with Internet Explorer.
Written Translation - a careful written record of spoken words, but
translated into a different language. (This is different than a transcription.)
For a session, if a written translation was produced outside of
SayMore, you can add that file to the session and then rename it to
include Written Translation. Then, the Written Translation stage is
marked as completed.
To complete this stage in SayMore, enter written translations in the
Free Translation column.
See Also: Free Translation.

Symbols - not exhaustive
- Project tab icon
- Add Files button
- Video file icon
- Image (picture) file icons
- Audio file icon
- Sessions tab icon
- Session file, and Session tab icon
- Add Files button
- Audio and OralAnnotation files, and Audio tab icon
- Video file, and Video tab icon
- Image (picture) file, and Image tab icon
- Annotations file (ELAN file)
- Audacity Project file
- Microsoft Word file icon
- Microsoft Excel file icon
- HTLM file (Internet Explorer associated)
- Choose columns button
- Refresh button
- Regenerate (generated audio)
- Archive with RAMP (SIL)
- Incoming status symbol - no work has started yet on the session.
- In Progress status symbol - work has started on the session.
- Finished status symbol - all needed work is finished for the

session.
- Skipped status symbol - you decided to not develop the session at
this time.
- Oral Annotations Tools
- Manual Segmenter
or

- Play button

or

- Pause playback button

- Stop media playback button
- Playback progress slider

- Playback volume control
or

- Listen or Check Annotation button

- Record button
- identifies ignored segments
- Erase Annotation button

- the Notes tab is empty (no contents)
- the Notes tab is not empty

- the Notes tab contains a warning. Action is needed.

- calls attention to information provided when an input error or
other problem is apparent to SayMore. For example, your microphone
may have become disconnected from your computer.
- People tab icon
- Add Files button
- Person file, and Person tab icon
- no informed consent for person warning icon
- informed consent is in a document (text) file icon
- informed consent is in an audio file icon
- Refresh button
- place holder for picture (of person)
- the Notes tab is empty (no contents)
- the Notes tab is not empty
- the Notes tab contains a warning. Action is needed.

